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he IBM* Solution
Developer Program Technical
Support team is pleased to wel-
come you to Solutions "99, the
technical conference for solu-
tion developers that is spon-
sored by IBM, Lotus™ and
Tivoli.* Solutions "99 delivers answers to your

toughest development challenges and helps you
integrate the power of e-business in your solutions.
If you are a commercial development professional
who is building leading-edge, open solutions for
networked environments, Solutions "99 should be
an extremely beneficial experience.

The conference is packed with in-depth presenta-
tions, hands-on labs, insider case studies and plenty
of interaction with e-business experts and peers.
More than 100 sessions are scheduled that focus on
Java., XML, Linux, JavaBeans, IBM WehSpherv‘.
MQSeries*, Web and Web application servers and
much more! From the Solution Developer Program
Technical Support area, the Technology. Tools, and
Strategies track of the conference is featuring an
elective session on Technical Support and tools to
build your e-business solutions. This track provides
insight into the latest Technical Support offerings
available to solution developers.

The IBM Solution Developer Program provides
support and services to commercial software develop-
ers worldwide who build e-business solutions using
IBM technologies. The program can help you reach
broader markets. control your cost of doing business
and get products to market faster. Developers can
take advantage of no-charge software and tools,
hardware discounts and leases, cross-platform porting

and testing facilities, global marketing opportunities,

‘99 @

IBM Developer Support Online Web-based technical
support, the IBM Developer Connection and more.

Developer Support Online provides technical
support through an easy to access Web site that is
available 24-hours-a-day, seven-days-a-week. The
offering includes FAQs & HATs, sample code, infor-
mation maps, white papers and technical articles,
chat sessions and demos, Q&A forums and bulletin
boards. This new offering can help get your products
to market faster by providing technical support infor-
mation in one repository.

The Developer Connection offers one-source
access to more than 1,000 development tools on 14
platforms, plus IBM solutions for e-business. The
content is available for download from the Web and
on CDs. The Developer Connection Technical
Magazine is part of the offering and contains techni-
cal articles written by leading-edge developers.
Several articles in this special edition were written by
conference presenters.

For more information about the IBM Solution
Developer Program, visit our Web site at
www.developer.ibm.com. You’ll find the resources
to help you take advantage of the ocean of global
opportunities offered by e-business.

Solutions "99 is your chance to network with
experts, collaborate with peers, gain hands-on expe-
rience and education and witness e-business solu-
tions from the real world. I look forward to meeting
and talking with you at Solutions "99 and encourage

you to attend as many technical sessions as possible.

)
g

Roy'Aho

Manager, Solution Developer Marketing Technical Support

www.developer.ibm.com/devcon/
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by Jean Swanson

-business allows you to operate locally and
sell globally. To become an e-business requires
access to new technologies as well as managing
your time and resources more effectively.

One of the best ways to “deal” with e-
business is by utilizing the tools, information
and technical support available through the
Developer Connection and Developer
Support Online. Both offerings are part of
the IBM Solution Developer Program.

The Developer Connection puts the tools
and information you need at your fingertips
through our online catalog, our CD set and
our technical magazine. This July Special
Edition of the magazine contains articles by
several of the presenters at Solutions "99. On
the front lines of the e-business revolution,
the authors share the latest developments in
open, integrated technologies.

The lead article, “Parallel Worlds: Why
Java and XML will succeed,” is by Simon
Phipps, Programme Manager, IBM Centre for
Java Technology in Hursley, England. Simon,
who is the chief XML and Java evangelist for
the IBM Corporation, is hosting the power
lunch on Wednesday, July 21. Don’t miss this
article and don’t miss his power luncheon!

“Using Java to bridge Domino™ R5 and
WebSphere,” by Jim Hsu and Bill Lawton, dis-
cusses how to install WebSphere onto the
Domino R5 server and how to use Java effec-
tively in this environment. Together,
WebSphere and Domino R5 open the door to
exciting possibilities for e-business solutions
that leverage the strengths of both technologies.

We’ve included two articles on Enterprise
JavaBeans (EJBs): “Enterprise Java Beans:
an IBM Unifying Model,” by Mickey Nix and
“Deploying \"isuzll:\ge* for Java Enterprise
Beans to the WebSphere Application
Server,” by Howard Borenstein. EJBs are
logical bridges between application clients

and data servers. This programming model is

Wsiness has arrived —

deal with it!

robust and flexible enough to allow develop-
ers to build new component-based frame-
works, or to wrap legacy data and applica-
tions, and to deploy both solutions into a
single Web application server with a single
client interface.

You’'ll also find articles on a servlet
architecture for IBM SanFrancisco, business
intelligence on AS/400* and Java portability
on 05/390* by authors that are speaking at
technical sessions at Solutions ‘99. Check
out their articles and take in their sessions at
the conference.

e-business isn’t about re-inventing your
business. It’s about streamlining your current
business processes to improve operating
efficiencies.

Whether you're just taking the first steps
or are already engaged in e-business, taking
full advantage of the opportunities e-business
can present requires planning. It also requires
ready access to new technology along with the
tools and information you need to accelerate
your development efforts.

New technologies...

New technologies bring excitement and an
ocean of possibilities to application develop-
ment. No matter what platform you are
developing for, the Developer Connection
can help you chart a course to navigate
e-business successfully. Visit our Web site at
www.developer.ibm.com/devcon/. We can
help you “deal” with e-business.

Come see us...

Be sure to stop by the Developer
Connection booth on the exhibit floor to
visit with us. We always enjoy talking to you
and getting your input on how we are doing.
Let us know what we can do to make the

Developer Connection program even better!
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way of life
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THE IBM OS/2 DEVELOPER’S TOOLKIT,
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by Simon Phipps

" n the last few years,
the focus in comput-
ing has gradually
moved away from the
raw technology and

has most receml_y set-
tled on the total cost of ownership (TCO) for a
solution. But what makes up the TCO? That's
hard to say, and everyone has a different
answer. It usually depends on what they find
casiest to fix! Most people agree that the TCO is
not made simply from the sum of the prices of
the parts that make the system. It comes from
those initially, but a much greater cost in the
end can arise from the cost of supporting the
system in context. A popular approach to
reducing TCO has been to try to centralize the
administration of individual systems, the client
desktop or both, but that's only part of the
answer. It's good to keep the amount of travel
to a minimum, but what actually causes the
administration to be needed? The answer, of
course, is change. But not on its own. Change
in isolation would only necessitate work on the
change itself. We all know that making a
change in one part of a system results in sup-
port needs throughout the whole system.

The typical computer system often is head-
ed toward “entropy death,” where the cost
exceeds the value, and where ordered simplici-

ty has tended towards interconnected complexi-

The typical
computer system is
often headed toward
“entropy death,” where
the cost exceeds
the value.

ty. While a cure for the symptom may be cen-
tral administration, the actual disease mandates
avoidance of the complex network of depen-
dencies in the first place. It is this avoidance
that Java and XML start to address by helping
eliminate the automatic co-dependency of sys-
tems, software and data.

A new world

The need for much of the support and
administration comes from the web of depen-
dencies woven by the software in our comput-
ers. To bring back the simplicity, we need to
cut the dependencies. Where are they all?
There are several categories:

- Software to platform

- Software to data

- Software to software

- Platform to platform

To cut the cord of these dependencies is not
easy, but the new world of computing that has
been developing over the last decade is finally
coming to maturity and making it possible.

Let's first consider the computing model we
have been living with. When computing was
new, the choices were easy to make. I could pick
any of the limited range of computers, write soft-
ware to run on it and create file formats to store
the data in. Trouble was, the software and data
would only work on that kind of computer, so
when a different kind was used I had to use dif-
ferent software, or if I used different software on
the same system I could not use the same data
and had to learn a new user interface.

Many of the problems were solved by two
standardization steps: many people began to
use the IBM PC initially with DOS and then
Microsoft* Windows.* A degree of simplicity
came back. But as time went on, it became
clear that there was still plenty of scope for
complexity to creep in! In particular, agreeing
on the platform did not break the platform
dependency of the software; it just meant it
was all co-dependent. So when an update
came along, everything might break! In addi-
tion, there was no standardization beyond the
power of monopoly in the world of the data.

Just as the software depended on a particular
level of the platform, the data

related to a particu-
lar

level of a
particular brand of the
software. A complex web of depen-
dency was woven, where a change at any
point might lead to instability and perhaps
failure in the whole web.

Co-dependency

A great enemy of computing is the creation
of unintentional co-dependencies. As computer
solutions are built, they all involve relation-
ships between the software, the hardware, the
platforms, the development tools and so on.
Each is connected to every other by unseen
connecting threads of co-dependency. Over
time, the cost of owning any solution is propor-
tional to the number of support dependencies
between the parts. But by the unintentional
creation of many co-dependencies, the cost
rises in an exponential rather than a linear
way. The result is that the addition of further
co-dependent elements can increase the life-
time cost disproportionately. The point at
which this begins to apply is the race point,
and the condition beyond the race point is
termed entropy death. The inevitability of
entropy death is set well before the race point
by the act of choosing a system philosophy
prone to co-dependency, the unwitting reliance
of one part of a system with another, possibly
mediated by some other element. The most
common unwitting co-dependency is between
software and the operating system it predicates.

This is not to say that all co-dependencies
can or should be avoided; it is inevitable there
will be some. But in modern system specifica-
tion and design they all should be identified
and justified in the same way as any other cost
driver, taking into account not only the direct
cost but also the lifetime cost inherited by con-
nection to the dependency network as shown in
Figure 1. In general, software needs to be insu-
lated from the environment where it is used. In

CONTI D ON PAGE 4



CONTINUED FROM PAGE 3

A

Ent'ropy
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Figure 1. Cost and entropy death

some situations, use of native interfaces and
binaries is unavoidable, but in these cases a
platform-neutral 'wrapper' around the native
code is almost always valuable.

For example, consider the apocryphal case
of a company that has used the macro language
of an office suite as the basis for an office
automation system. One day, the company’s IT
group installs another piece of software and
unknowingly updates one of the DLL files used
by the office suite. They find that one of the
macros no longer works. After a great deal of
work, they manage to get the macro working
again, but the new version needs an updated
version of the spreadsheet program. To get
that, they have to install a whole new level of
the office suite, after which none of the macros
work! They next crawl through all the macros,
updating and fixing them. Among the other
things the fixes mandate, they discover they
need to use a new version of the database dri-
ver. Sadly, that needs the latest version of the
database to work. So they upgrade the database
and...well, you can guess the rest.

The new foundation

The problem is caused by the transmission
of the impact of change from subsystem to sub-
system. The integrated computing foundation
currently in use in most systems can act as a
transmission medium, allowing change in one
place to have an impact elsewhere.

How can we escape this trap? The key to it
all is to disconnect data from software from
platforms, to use standards-based choices for all
of these so that version-to-version variations of
the implementation have the smallest effect
possible. By doing this, we isolate changes from
the transmission medium (the underlying plat-
form) and prevent the impact of change from
causing shock-waves of cost: we add the insu-
lating layer mentioned earlier. What would be
an optimal base of standards? The technology
domains, shown in Figure 2, such a foundation

would have to cover are:

* The network protocols holding systems
together and providing access

* The delivery model that brings the solu-
tion to the audience that needs it

* The programming model with which the
solutions are created

* The data structuring model for the infor-
mation the solutions consume

* The security model that allows the
right audience access to the right data
and solution

Much of the change in the computer
industry over the last decade has involved the
rediscovery of technology ideas and their
establishment as standards within that model.
The mappings, shown in Figure 3, are:

*  Network: TCP/IP

The use of TCP/IP has now become so

widespread that it is no longer a topic of

conversation.

Delivery: Web model Stateless Client/Server

Stateless client/server computing is the

chosen delivery mechanism of a growing

number of business computer users.

Rather than creating state-full clients,

which need costly maintenance and sup-

port, state is instead maintained at the
server and at most “loaned” to the client.

* Program: Java and JavaBeans
Only four years from release. Java has
established itself as the standard for new
software in a vast number of enterprises:
its JavaBeans architecture allows compo-
nent-based development to be used in
earnest. This is not to say that all the code
needs to be written in the Java language:
it's the platform-neutral Java bytecode
binary programs that win. Where these
aren't feasible, at very least a wrapper of
Java to insulate the rest of the solution from
native code is essential.

*  Data: XML and vocabularies
Apparently new to the scene, XML is actu-
ally simplified SGML - 80 percent of the
function for 20 percent of the complexity.
Uptake throughout the computer industry
has been huge and it shows every sign of
dominating data formatting in the future.

*  Security: Public key
By removing the need to send full key
information “in the clear.” public key-based
security systems are already dominant,
especially on the Web.

solutions

Figure 3. The new foundation

From technologies to audiences

Alongside the agreement of the standards
for the new world of computing has been a
shift in the requirements for business solu-
tions. In the past, each solution would be built
with the requesting customer only in mind.
The focus was on who was using the solution
and where they were, hence terms like
intranet, extranet and Internet. But progress
has meant that the focus now is much more on
the modelling of all the data and the definition
of the relationship of the user to the data.
There has been an inversion in the approach
to computing solutions, and the focus has
switched from technologies and systems to
information and audiences.

Today, defining a new solution involves




defining the relationship that an audience has to
a body of information. In most cases, a given
body of information has multiple audiences.
Thus, for an online shop when customers are
viewing information, generally access is given
only to their particular data and it can be pre-
sented in a way to suit them. When customer
service staff from the vendor view the same
information, both the scope and the presentation
differ. It is the transition to a solutions-and-audi-
ences view that presents the greatest challenge
in IT today. Users are able to proceed with con-
fidence because all of the technologies in the
new tradition are in fact mature and proven, so
the transition is one of emphasis and strategy

rather than a leap into unknown technology.

Parallel worlds

The fact that all five of the foundation tech-
nologies are well understood also offers another
benefit. For many users, migration to the new
world of e-business is something evolutionary
rather than revolutionary. They are able to
take the first steps without scrapping all the
investment that they already have made. So
this new world is in fact a parallel world rather
than an alternate world.

So why, after all that, will Java and XML
succeed? There are several reasons why:

*+  Proven technology: All five of the segments
of the new foundation are based on the old-
est, most proven ideas in the industry.
TCP/IP, “dumb terminals,” virtual
machines, mark-up languages, public key

»ms — all have been proven through

decades of use.

User driven: In the final analysis, the move to
the new foundation is driven by the needs
and desires of the marketplace rather than by
the fiat of any one vendor or even of a con-
sortium. As the costs of computer technology
become more of a focus item and those dri-
ven by the upgrade arms-race toward entropy
death become more and more obvious, the
demand for the new foundation becomes
greater and greater.

Vendor supported: All five technologies
form the basis of almost all vendors’ new
solutions. Vendors choosing an alternate at
any point increasingly discover the market
questioning their choice and suspecting an
attempt at proprietary lock-in.

Platform neutral: All five technologies are
independent of each other and of the plat-

forms where they are used. Thus, they all

CONTINUED ON PAGE 6

XML

Keeping the information in the data!

WiTH ITS ROOTS IN SGML (ITSELF THE DEVELOPMENT OF WORK CARRIED OUT BY IBM
IN THE LATE '60s), XML IS VERY SIMPLY THE IDEA OF USING TAGS FOR FORMATTING ALL
DATA, NOT JUST TEXT INTENDED TO BE DISPLAYED IN A WEB BROWSER. YOU MIGHT
ALREADY INSERT PSEUDO-HTML IN YOUR E-MAIL, LIKE THIS:

<JOKE> WHY DID THE CHICKEN CROSS THE ROAD ?</JOKE>

<PUNCHLINE> TO GET TO THE OTHER SIDE </PUNCHLINE>

WHEN YOU DO THIS, YOU'RE ACTUALLY CREATING A FRAGMENT oF XML! You’ve
DEFINED A SMALL VOCABULARY FROM WHICH THE TAGS YOU'VE CHOSEN ARE DRAWN
(LET’S cALL IT JOKEML), YOU’'VE MADE SURE IT IS WELL-FORMED (HAS CLOSING TAGS
TO MATCH ALL THE OPENING TAGS) AND APART FROM A LINE TO SAY WHERE THE DEFIN-
ITIONS OF THE TAGS CAN BE FOUND (A DocumeNT TYPE DEFINITION OR DTD) AND A
LINE TO SAY IT’S XML, YOU'RE ALREADY AN EXPERT! ANYONE WHO UNDERSTANDS WHAT
A JOKE IS WILL UNDERSTAND THIS DATA (ALTHOUGH THERE IS NO GUARANTEE THEY WILL
FIND IT FUNNY), SO INSTEAD OF JUST BEING DATA IT’S TURNED BACK INTO INFORMATION.

As MORE AND MORE VOCABULARIES ARE DEFINED, XML IS BEING USED FOR TAGGING
DATA IN ALL SORTS OF APPLICATIONS. IT HAS THE GREAT BENEFIT OF BEING DIGESTIBLE
BY COMPUTERS AS WELL AS HUMANS — AFTER ALL, SOMETHING LIKE:

<DL>

<DT> WHY DID THE CHICKEN CROSS THE ROAD?
<DD> TO GET TO THE OTHER SIDE

</DL>

MIGHT CLEARLY BE A JOKE TO HUMAN EYES BUT A COMPUTER WOULD NEVER GUESS,
WHEREAS THE XML FRAGMENT WOULD BE ACCESSIBLE TO ANY PROGRAM THAT UNDER-
stoob JoKEML.

XML wiLL BE USED IN THE FUTURE ANYWHERE THERE IS DATA — NOT JUST ON THE
WEB, AND CERTAINLY NOT JUST IN WEB BROWSERS. BY PUTTING THE FRAMEWORK OF
MEANING BACK INTO THE DATA, IT BRINGS LIFE TO THE DATA, TURNS THE WORLD WIDE
WEB INTO A WORLDWIDE DATABASE AND MAKES COMMUNICATION BETWEEN BUSINESS-
ES POSSIBLE WITHOUT ALL THE PAIN OF THE EDI PROCESS.

To LEARN MUCH MORE ABOUT XML AND RELATED STANDARDS, TECHNOLOGIES AND
TECHNIQUES, START AT http://www.ibm.com/xml/



can be implemented anywhere, insulating
the systems that depend on them from
co-dependency.

Vendor neutral: All five technologies are
beyond the control of any one vendor, so
that investments are protected from both the
risks of vendor lock-in and also from the
design choices of any one vendor starting an
upgrade race. The only possible exceptions
to this are Java and public key, and it is
worth taking time to consider why neither is
a problem in this context.

Java: public property?

Can a technology developed and apparently
controlled by a single vendor be considered
open? It all depends on the attitudes and actions
of the vendor. In the case of all five domains in
the new computing foundation, control has
passed from the originator to “the mind of the
market.” For example, although the core ideas of
public key systems are owned by one company,
the industry has been willing to base almost all
encryption and digital signatures on that technol-
ogy, because of a combination of the open power
of the technology and the attitude of the owners
of the core patents. In the same way, Java has
become public property that is currently protect-
ed rather than compromised by the owner of the
core technology, although a move to standards
body control would be positive. What is more,
that ownership is nowhere as firm as in the case
of public key systems. If the whole industry chose
to implement Java differently, there would be
almost no recourse. But that does not happen
because any company seen to violate the value of
Java is shunned by the market. The fact that the
base of standardization in Java is actually the
binary format of bytecodes rather than the lan-
guage is, of course, a big help. Thus, if we feel
safe basing key parts of the computing infrastruc-
ture on public key systems, there is all the more
reason to feel safe using Java.

Conclusion

The key issue that should occupy us is not
“how can I cut the cost of administration and
support” but rather “how can I reduce towards
elimination the amount of admin-support that
is needed?” To reflect this changed concept,
and to progress from the notions that some-
times turn consideration of TCO into TCP
(total cost of purchase), we should perhaps use
a modified term to express the issue in hand —
lifetime cost of ownership or LCO.

The core assertion of this article is that the
primary decision factor for new computer systems
should be the cost of owning the system over its
entire life: that is, to base a decision on LCO — of
software, network, client and server hardware,
complete with development, deployment, admin-
istration, management of impact during life-cycle
and migration to replacement systems at sun-
down. The core proposal of the article is that this
factor can be controlled by minimizing the net-
work of co-dependent complexity that these vari-
ous elements create. To achieve this control, a
change of system philosophy rather than an

instant change of technology is proposed. By bas-
ing future developments on a firm foundation of
standards, entropy death can be avoided. And this

is the reason Java and XML can succeed, cool

though the technologies themselves may be!
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Using Java to bridge

by Jim Hsu and Bill

Lawton

* he recent release
of WebSphere 2.02
and Domino R5 cre-
ates a winning combi-
nation for sophisticat-
ed enterprise-class
Web sites. Domino
provides a Web-

enabled foundation

for group collabora-
tion and workflow.
WebSphere is used to power Web applications
that utilize servlets and Java Server Pages (JSP).

WebSphere Standard Edition is packaged
with Domino R5, but WebSphere Advanced
Edition also can be installed and used with
Domino R5. WebSphere Advanced Edition pro-
vides Enterprise JavaBeans (EJB) support.

Together, WebSphere and Domino R5 open
the door to exciting possibilities for e-business
solutions that leverage the strengths of both
technologies. This article discusses how to install
WebSphere onto the Domino R5 server and how
to use Java effectively in this environment.

Enabling WebSphere on Domino R5

WebSphere plugs into a variety of popular
Web servers, including Apache Server,
Netscape FastTrack and Enterprise Servers,
IBM HTTP Server, Microsoft Internet
Information Server (IIS) and, of course, Lotus
Domino R5.

To enable WebSphere support on a
Domino R5 server, simply select the Domino
R5 Web server plug-in option during the
WebSphere installation process. Make sure the
JSP check box is selected during installation
to ensure automatic configuration of Domino
R5 for both servlet and JSP support. After
installation, the server hostname field should
be set in the Domino server configuration.
Figure 1 shows the handling of incoming Web
requests by a Domino R5 server with
WebSphere installed.

Any existing WebSphere application is easily

moved to Domino R5. The Web server files for
the application are copied into the Domino
HTML directory at \Lotus\Domino\Data\domi-
no\html. If the application uses SSL, check that
Domino SSL support has been enabled. If not,
create a keyring using the Domino R5 Certificate
Authority database (cca50.ntf) and set the
keyring field in the Domino server configuration.
Domino R5 and WebSphere also can be
used in combination with 1IS. The 1IS Web
server plug-in option should be selected during
the WebSphere installation process. In this
configuration, both Domino and WebSphere

receive Web requests from I1S

have easy access to HTTP parameters, session
state and cookies. A big potential advantage to
using servlets is that they stay loaded in mem-
ory until the server is shut down or

restarted. This can provide a
big performance
boost

over CGI-

BIN programs and
Domino agents, which are loaded
each time they are invoked and unloaded as
soon as they are finished executing.

server as shown in Figure 2.
Java objects in WebSphere
and Domino
Now that we have a server
running Domino and WebSphere,

we can start to look at the possible

benelfits of interoperability. The

key is to leverage the interactions

Domino HTTP
Server Task

between objects in both the

WebSphere and Domino environ-

ments by using Java as a common
language to bridge the two. Let’s
start with an examination of the

Java-based features in WebSphere

and Domino so we can under-
stand the potential advantages of
using them together.

WebSphere servlets are Java
software components that execute on the serv-
er and follow the Servlet API. As such, they

Together, WebSphere
and Domino RS open the

door to exciting possibilities
for e-business solutions

that leverage the
strengths of both
technologies.

Figure 1: Delegation of Web requests on Domino R5 with

WebSphere enablement

WebSphere also comes with JSP support,
which allows a page creator to mix Java code
"snippets" into HTML. JSPs provide scripting
language support that executes on the server.
JSPs are compiled into servlets at run time, so
they generally enjoy the same performance
benefits as servlets.

The Advanced Edition of WebSphere pro-
vides support for Enterprise JavaBeans. EJBs
are reusable software components that can be
transactional, persistent, distributed and secure.
These properties are important for creating e-
business Web applications.

In Domino, there are several ways to pro-
gram in Java. Java applets can be embedded

CONTINUED ON PAGE 8
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Figure 3. Accessing Domino objects from WebSphere
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<HTML><HEAD> <TITLE>AgentFromJSP.html</TITLE></HEAD>

into Domino Web pages.
Also, a Java program
running locally on the
Server can access
Domino objects with
server permissions
through the Notes APL
The Notes API also

<BODY BGCOLOR="#FFFFFF">

<H1>AgentFromJSP Login Form</H1>
This form will submit data to a <B>JSP</B> for processing.
<P>Please log in using your userid and password.

<FORM METHOD="POST" ACTION="AgentFromJSP.jsp">

<FONT SIZE=2 FACE="Arial">User ID: </FONT>

<INPUT TYPE="TEXT" NAME="uid" SIZE=20 MAXLENGTH=20><BR>

<FONT SIZE=2 FACE="Arial">Password: </FONT>

<INPUT TYPE="PASSWORD" NAME="pwd" SIZE=20 MAXLENGTH=20><BR><BR>

<INPUT TYPE="SUBMIT" NAME="submit_btn" VALUE="Submit">

allows access through a
remote I1OP interface.
Finally, a Java agent can
be used. Java agents are
programs that reside in a
) <%
Domino database and
perform actions on
behalf of a user. Like
servlets, they can be trig-
gered from a URL, but
agents also can be
scheduled to run every
so often or when a serv-
er-side event occurs.
Additional details
about using the built-in
Java support in Domino
can be found in the arti-
cle "Writing Java
Programs for Domino
R5.” This article was %>
published in the June
issue of IBM Developer
Connection Technical Magazine and
contains detailed sample code
including versions of the
AgentLauncher and
DocumentCreator classes that are

used in the next example.

Accessing Domino objects from
WebSphere
WebSphere servlets, JSPs and
EJBs can access Domino objects
using the remote I1OP interface to
the Notes API (as illustrated in
Figure 3). In our first example, a JSP
was used to trigger a Domino agent.
Because resources in Domino
may be protected by Domino access
controls, you can use a Domino user
ID and password to obtain proper
security permissions. This informa-
tion is first gathered in a Web login
page shown in Listing 1. This is an
HTML form that calls our JSP with
two parameters, uid and pwd. The
JSP extracts the two parameters and

solutions

out.printin("Executing Agent on behalf of user " + uid);
out.printin("\n<P>");

<INPUT TYPE="RESET" NAME="reset_btn" VALUE="Reset">
</FORM></BODY></HTML>

Listing 1. AgentFromJSP HTML Login Form

<%@ import = "java.io.* java.util.* lotus.domino.*" %>

String[] values;
String uid = "";
String pwd = "";

values = request.getParameterValues("uid");
if ((values != null) && (values[0] != null) && (values[0].length() > 0))
uid = values[0];

values = request.getParameterValues("pwd");
if ((values != null) && (values[0] != null) && (values[0].length() > 0))
pwd = values[0]; J

// Create AgentLauncher

test.AgentLauncher agentLauncher = new test.AgentLauncher();
agentLauncher.uid = uid;

agentLauncher.pwd = pwd;

Thread thread = new Thread((Runnable) agentLauncher);
thread.start();

Listing 2. AgentFromJSPjsp File

uses them on the AgentLauncher object provid-
ed in Listing 2.

AgentLauncher uses the login information
to create a remote IIOP session with a Domino
server. If the user permissions are correct,
AgentLauncher obtains a DocumentCreator
agent and executes it. The source code for
AgentLauncher is given in Listing 3.

To use AgentLauncher, be sure to customize
the constants for your system and compile it.
The resulting AgentLauncher.class file should
be copied into the WebSphere\AppServer\
web\classes directory so that it can be loaded
by WebSphere. For WebSphere to run
AgentLauncher, the remote session classes from
the Domino NCSO jar file should be added to
the WebSphere bootstrap.properties classpath.

Accessing WebSphere EJBs from Domino

Our second example uses [IOP to access a
WebSphere EJB from a Domino agent. This
scenario is illustrated in Figure 4.

Listing 4 gives the source code for a Domino

s the IncBean EJB sample that

agent that acces

is included in WebSphere Advanced Edition. It




is essentially a modified version of the
com.transarc.jmon.examples.Inc.IncClient class.
When the agent is executed, a counter is incre-
mented by five in the database just like in the Inc
demo in the WebSphere EJB samples page. The
samples page is installed locally on the server by
WebSphere at http://servername/IBMWebAS/
samples/ejs/index.html.

Because this agent uses outside classes like
IncBean, it uses the "Imported Java" option
with the following three files:

+  EJBFromAgent.class (Customize and com-

pile the source code from Listing 4)

+ Incjar (located in

\WebSphere\AppServer\deployableEJBs)
+  ejsjar (located in \WebSphere\AppServer\lib)

e-business example scenario

The above samples demonstrate two-way
interaction between WebSphere and Domino
objects. Next, let’s discuss an example e-business
scenario that takes advantage of this interoper-
ability by using servlets, EJBs and Domino
agents together to automate the task of e-mail
confirmation.

Many e-business Web applications require
users to provide a valid e-mail address. This
feature is especially important to applications
that need to send information to customers. For
example, a requirement for an online trading
site might be that a prospectus must be sent to
all mutual fund buyers. If the customer has a
confirmed e-mail address, the prospectus can be
sent by e-mail instead of regular mail, thereby
cutting costs. Another example is the use of a
confirmed e-mail address to allow users to sub-
mit bids on an online auction site.

To implement e-mail confirmation in
WebSphere you might have an HTML form
with a submit button that calls a servlet. The
servlet processes the data that was entered and
creates an EJB instance containing data for the
user. Then, the servlet sends a confirmation
message to the user. To send the e-mail using
the Domino R5 mail server, the servlet could
create a mail document and send it by calling
the Notes API, much like the first example.
This technique also could be used to subscribe
to a mailing list from a Web page or to send
confirmation e-mail when a user makes a pur-
chase from an e-commerce Web site.

A convenient way for the user to activate the
account is to reply to the confirmation e-mail. If
this is the case, you need a Domino agent to
handle the responses. You set the agent to run

when new mail is received, so it is
triggered when the user replies. The

agent could verify the message and

call an account management EJB to

activate the user’s account. This uses

the technique described in the second

example. Similar agents might handle

account deactivation or mailing list

unsubscribe requests.
Summary
The interaction of WebSphere
and Domino objects has been made
possible by open APIs that cross both
environments using the IIOP proto-
col. WebSphere servlets, JSPs or EJBs

can access Domino objects using the

Notes APIL. Conversely, Domino
agents can access EJBs running on
WebSphere. The samples and scenar-
ios in this article provide a good start-
ing point from which to build e-busi-
ness applications that take advantage
of the full potential of WebSphere

and Domino interoperability.

Jim Hsu is a Software Engineer who
joined IBM in May 1997. He is a
member of the Software Group
Technology Center in Austin, Texas.
Jim received his bachelor's and mas-

Listing 3. AgentLauncher Source Code

ter's degrees in electrical engineering
and computer science from MIT. He is
interested in technologies with imme-
diate widespread impact and has
worked on the development of Java
programs that involve the Internet.
You can contact him at
Jimhsu@us.ibm.com.

Bill Lawton is a Senior Development
Manager. He currently manages the
Software Group Technology Center.
The SWGTC innovates in the areas of
e-business framework middleware
with a focus on Web-based Java soft-
ware technologies. Bill is the author
of a book on multimedia and holds
several patents. You can contact him
at lawton@us.itbm.com.

Listing 4. EJBFromAgent Source Code
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by Mickey Nix

ava components
have become an
important part of
client-side program-
ming, and the
JavaBean specification
has proved its value.
With the emphasis now on server-side comput-
ing, demand has risen for a similar component
model on the server. As customers and vendors
engineer multi-tier applications, Enterprise
JavaBeans (EJBs) are emerging as a common
design point and provide a standard, open,
cross-industry component model for developing
middle-tier (application server) architecture.
IBM recognizes the importance of Enterprise
JavaBeans and is an active and significant part-
ner in the promotion and definition of EJB and
Java technology. In addition, IBM has refocused
its internal software development efforts making
EJBs a first-class element across the middle-
ware, tools and applications in the IBM
Application Framework for e-business.

EJBs are logical bridges between application
clients and data servers. Today’s Web application
servers provide enterprise Java services and facil-
ities that allow developers to exploit and inte-
grate new and legacy applications with a com-
mon external interface. When defining a server-
side component model, there are many factors
that must be considered, but three dominate:
data representation or persistence, object services
and client-side access.

The EJB programming model is robust and
flexible enough to allow developers to build new
component-based frameworks or to wrap legacy
data and applications, and to deploy both EJB
solutions into a single Web Application Server
with a single client interface. While it is beyond
the scope of this paper to describe the EJB spec-
ification in detail (more information can be
found at java.sun.com), this paper examines IBM
products that are EJB-enabled today and specu-
lates on what the future may hold.

EJB development environment
VisualAge for Java Enterprise Edition Version
2.0 with Rollout2 and Enterprise Update pro-

JavaBeans:

vides an EJB development environment for cre-
ating, testing and deploying session (transient)

and entity (persistent) EJBs. An entity EJB pro-
vides an object view of persistent data. The EJB

container masks the complexities of mapping this
object view to a relational database. This masking
is important because it allows a programming
team to simplify their designs by separating
objects and business logic from underlying data-
base, transaction and security programming
details; it is the implementation of the container
that provides these complex mechanisms and
services. Currently VisualAge for Java (VAJ) pro-
vides support for building session EJBs, bean-
managed persistence (BMP) entity EJBs and con-
tainer-managed persistence (CMP) EJBs for IBM
Universal DB2* 5.2 databases.

The VisualAge for Java integrated develop-
ment environment (IDE) also includes a minimal
IBM WebSphere Application Server that can be
used for testing and debugging CMP and other
types of EJBs within the IDE itself. These EJBs
can be exported as Java JAR files and then
deployed and executed in WebSphere
Application Server (WAS) 2.0 Advanced, which
provides container support for Universal DB2
databases. Even though WAS 2.0 Advanced is
IBM’s initial release supporting EJBs, the offering
meets Sun’s EJB specifications and provides sup-
port for deploying entity EJBs. In addition, a beta
version of Component Broker 2.0 provides a set
of tools that allow developers to wrap existing
EJBs as Component Broker managed objects.
Wrapping the EJBs gives them access to even
more robust run-time management services such

as workload management and availability man-

Enterprise
JavaBeans (EJBs)
are emerging as a common
design point and provide a
standard, open, cross-industry
component model for
developing middle-tier
(application server)
architecture.

solutions

agement over multiple servers in addition to

persistence, transaction and

security func-

tions. The
following EJB cre-
ation example steps through the

process of creating, testing, and deploying a

CMP bean using IBM’s tool suite.

With EJBs, object-oriented application
development can be approached in the follow-
ing ways:

+ Top-down: Objects are directly derived
from functional requirements — modeling
and analysis define the classes and behav-
iors that must be implemented.

*  Bottom-up: Objects are engineered to
wrapper existing functions, applications and
databases — which preserves investments in
legacy systems and improves productivity
through reuse of existing classes.

*  Meet in the middle: Objects are created
using a combination of the top-down and
bottom-up approach.

While top-down development is considered
the more ideal model for object-oriented devel-
opment, the meet in the middle approach is
used more often in customer and vendor appli-
cation development where it is important to
slowly integrate a new object-oriented frame-
work and preserve existing development efforts.

In the following example, the bottom-up
approach is used to reengineer a legacy database
named SAMPLE that ships with Universal DB2.
Specifically, the example creates a CMP bean to
wrapper the SAMPLE table entitled EMPLOY-
EE. The EMPLOYEE table contains the follow-
ing fields: EMPNO (a primary key representing
an employee number), FIRSTNME, MIDINIT,
LASTNAME, WORKDEPT, PHONENO, HIRE-
DATE, JOB, EDLEVEL, SEX, BIRTHDATE,
SALARY and BONUS.

The CMP bean is created, tested and
debugged within the VisualAge for Java EJB
development environment and then deployed in
the WAS. Following that example will be a brief
discussion of how the object then can be
deployed in a Component Broker run time at
some point in the future. The exercise is meant

to provide a quick-start to developers who want




to explore the VisualAge for Java EJB develop-
ment environment for the first time. Sample
code and a detailed set of instructions for work-
ing through the exercise can be found on the
Developer Connection Web site and CDs in a
Freelance® format.

Preparing the development environment

The following instructions assume that
Windows NT* 4.0 with Serviced Pack 3 has
been installed on a workstation. Begin the
preparation of the development environment
by installing the IBM WebSphere Application
Server 2.0 Advanced product. This single
installation program installs JDK 1.1.6, IBM
Universal DB2 5.2, the IBM HTTP Server and
the IBM WebSphere Application Server.

After the installation completes and after
rebooting, complete the following steps to fur-
ther configure the development environment:

1. Using the DB2 Control Center, break down
the System tree until the DB2 element is vis-
ible. While the DB2 element is selected,
choose Selected > Configure from the menu
to invoke the Configure Instance — DB2
window. From this window, specify the Java
Development Kit 1.1 Installation Path.

2. From a Web browser, link to http://local-
host:9527 to invoke the WebSphere
Application Server Administration Tool.
Log in and go to the Setup > Java Engine.
Ensure that X:/SQLLIB/Java/DB2Java.zip
(where X is the drive on which Universal
DB2 has been installed) appears in the
Application Server Classpath.

3. Next, install VisualAge for Java 2.0,
Enterprise Edition, the Rollout2 fix pack
and the Enterprise Update — in that order.
The Rollout2 and Enterprise Update patches
can be found at the VisualAge for Java Web
site at www.software.ibm.com/ad/vajava or
on the VisualAge Developer Domain link at
www.software.ibm.com/ad/r/vadd8.

4. After installing the Enterprise Update, go to
the VisualAge for Java Workbench and
select File -> Quick Start > Features ->
Add Feature -> IBM EJB Development
Environment 1.1 to actually add the EJB
development environment to the integrat-
ed development environment in VisualAge
for Java.

Two additional steps to enable a JDBC
connection between VAJ’s database schema
mapping utility and DB2 are needed later in

the exercise:

L. Unzip X:/SQLLIB/Java/DB2Java.zip into
a temporary subdirectory.

2. From the VisualAge for Java Workbench,
import the temporary subdirectory into
the workspace.

Adding and importing EJB groups and
EJBs
To build an EJB. do the following as
shown in Figure I
1. Go to the VisualAge for Java Workbench
and add a new project. In this example
the project is named EJBSampleDB.

2. Switch to the EJB tab on the Workbench
and select Add -> EJB Group to create a
new EJB group named
IBM_Sample_DB_EJBs and associate it
with the EJBSampleDB project.

3. Right click on the newly defined group to
invoke its pop-up menu and select Add -
> EJB to add an EJB to the group.

This exercise focuses on the creation of
an entity EJB with container-managed per-
sistence (CMP) fields that encapsulates the
fields of the EMPLOYEE table in the SAM-
PLE database. Name the bean Employee and
ensure that its bean type is Entity Bean with
container-managed persistence fields (CMP).

On the second page of the SmartGuide,
select that the Create finder helper interface
to support finder methods check box and
press the Finish button. The following classes
are generated by the Create EJB SmartGuide
and appear in the Types pane of the EJBs
development page.

* Employee (Remote Interface): Defines the
methods implemented by the EJB

+  EmployeeBean (EJB Implementation):
Provides the server-side implementation

of the EJB
+  EmployeeHome (Home Interface): Defines

the methods used to create or find the EJB
+  EmployeeKey (Key Class): Used as a method

parameter to create or find an entity EJB

+  EmployeeBeanFinderHelper (Finder

Helper): Helper class for special find meth-

ods for CMP entity EJBs

The generated classes and interfaces are
independent of the EJB container and, with
VisualAge for Java, all of these classes and
interfaces can be managed as a single entity in

the EJBs pane of the EJB development envi-

L | SmartGuide

EJBSampleDB S
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Figure 1a. Building an EJB

ronment. For example, VisualAge for Java
helps ensure that when a method is deleted
from the EJB bean class, its corresponding
method in the remote interface is deleted auto-
matically. In addition, EJBs can be versioned as
a single entity and EJB source code and associ-
ated packages are synchronized.
Adding, defining and mapping
CMP bean fields

Once the initial EJB has been generated, a
field named primaryKey of typejava.lang.String
has been added. This field later is mapped to
the EMPLOYEE primary key column named
EMPNO. New data instance fields can be
added to the EJB to reflect the columns in
the EMPLOYEE table. For example, the fol-
lowing fields have to be added to the EJB
because their corresponding columns in the
EMPLOYEE table are tagged with the NOT
NULL attribute:

CONTINUED O
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public String firstName ;
public Character  midinit ;
public String lastName ;
public short edLevel ;

Of course, other fields such as:

public java.math.BigDecimal salary ;
public java.math.BigDecimal bonus ;

could be added, and are needed for the exercis-

es to follow.

To add a field, select EmployeeBean and
right click. Select Add -> Field from the pop-
up menu. In the Create Field SmartGuide,
make sure that the Access with getter and set-
ter methods check box is selected. After creat-
ing each of the fields, the new fields must be
designated as Container Managed fields. First,
press the Fields icon (circle with an F inside)
in the upper-right corner of the Types pane to
toggle to the Fields pane. Select each new field
and right click to invoke its pop-up menu. In
the pop-up menu, select Container Managed.
This tells the VisualAge for Java code genera-
tion tool that these fields should be mapped
automatically to an underlying data store such
as DB2. Additional steps are necessary to pro-
vide the code generation tool with the infor-
mation it needs to map the EJBs container-
managed fields to the EMPLOYEE tables in
the SAMPLE database:

1. Open the Schema Browser tool from the
VisualAge for Java Workbench (use the
“octopus-like” icon on the far right of the
tool bar) and import the EMPLOYEE
schema from the SAMPLE database. In this
example the schema has been saved to the
VisualAge for Java development environ-
ment with the name SampleDBSchema.

2. Using the Table Editor in the
Schema Browser, associate a
VapStringToCharacterConverter with the
MIDINIT table column as shown in Figure 2.
This allows mapping of a java.lang.Character
class to an SQL char type. By default all
fields are associated with VapConverter,
which passes datum “as is” without doing any
conversion.

Note: A better database design would use a Java

primitive character rather than the class

java.lang.Character — the approach used in this
article reflects the associated lab’s requirement
to demonstrate the use of a VapConverter.

3. Use the VisualAge for Java Map Browser to
associate the EJBs container-managed per-

sistent fields with EMPLOYEE data
columns, shown in Figure 3. To create an
EJB Group Map:

a. Click on the icon to the left of the
Schema Map icon on the tool bar
(looks like a globe with longitude
and latitude lines).

b. On the Datastore_Maps menu in the
Map Browser, select New EJB Group
Map — the New Datastore Map dia-
log appears.

c. Name the new map to be created
(SampleDBMap for example), associ-
ate it with an EJB group
(IBM_Sample_DB_EJBs) and associ-
ate it with an existing database
schema (SampleDBSchema).

d. On the Datastore_Maps menu in the
Map Browser, ensure that
SampleDBMap and Employee are
selected from the Map Browser and
then select Table_Maps ->
New Table Map -> Add table
map with no inheritance.

e. Ensure the new table map is
selected and then select
Table_Maps -> Edit Property Maps
to launch the Property Map Editor.

f.  On the Attributes pane of the
Property Map Editor, map the con-
tainer-managed fields of the EJB to
their corresponding table
columns in the EMPLOYEE
table.

Because each of the fields was a Java
primitive or String, each of the map types
is specified as Simple. However, it is possi-
ble to map complex objects (classes with
field types other than Java primitives and
Strings) using VapAttributeComposer classes.
The VisualAge for Java EJB Development
Environment documentation details how to cre-
ate these classes. Be aware that the documenta-
tion fails to mention one class that must be

added to a composer:

public TargetClass singleton() {
if (singleton == null) {
singleton = new TargetClass() ;
return singleton ;

}

For more information, see the EJB
Development Environment document that is

included with the Enterprise Update.

Adding create, finder and business methods
Now that the EmployeeBean is wired for
persistence, focus can be turned to adding create
and finder methods to the bean’s home interface

and to adding business methods to the bean’s
remote interface. An EBJ’s home interface per-
forms two roles: it provides factory methods for
creating instances of the EJB class and it func-
tions as a type of controller or manager in that
all SQL select queries against the underlying
datastore are contained here. When the EJB is
first generated, a default create method,
ejbCreate( ). is provided. In this exercise, the
developer will need to add at least one other
create method with a parameter list that can be
used to create and initialize a new Employee
EJB. Add a new ejbCreate method to the
EmployeeBean class by selecting Add -> Method
from its pop-up menu. The new method should
look something like:

public void ejbCreate(EmployeeKey key, String firstName,

Character midinit, String lastName, short edLevel,
Jjava.math.BigDecimal salary, java.math.BigDecimal bonus)

throws java.rmi.RemoteException, javax.ejb.CreateException

depending on how many columns from the
EMPLOYEE database were included in the
EJB fields definitions. The real trick is that
each of the container-managed persistence
EJB fields must be initialized in the create
method. For example:

primaryKey = key.primaryKey ;
setFirstName(firstName) ;
setMidlnit(midinit) ;
setLastName(lastName) ;
setEdLevel(edLevel) ;
setSalary(salary) ;
setBonus(bonus) ;

can be used in the new ejbCreate method
above. After the new ejbCreate method has
been defined, it must be promoted to the home
interface. To do this, right click the new
ejbCreate method in the Methods pane of the
EJB Development Environment and then select
Add to -=> Home Interface.

Next, add one or more finder methods to
your Employee EJB. These methods perform
SQL queries and return either single
Employee objects or java.util. Enumeration
objects. which contain multiple
EmployeeBean objects. The current EJB spec-
ification from Sun Microsystems does not pro-

vide for any other type of Java collection

object in finder methods.




To add a finder method

1. Select the EmployeeHome interface and
choose Add -> Method from its pop-up
menu.

2. Define a finder method such as:

3. Select Employee in the EJBs pane, and
select Generate -> Deployed Code from its
pop-up menu.

4. In the Types pane, you should see many new
classes (you can hide these classes from view
by clicking on the icon in the upper-right
corner of the Types pane that resembles a
piece of paper) — select the
EJSIDBCPersisterEmployeeBean.

5. Use the final static findByKeySQLString
string of this class as a model to complete
the next step. (Source code appears in the

Source pane when the
EJSIDBCPersisterBean is selected.)

6. In the Types pane, select the
EmployeeBeanFinderHelper interface and
add a statement similar to the following in

the Source pane:

The order in which the column names

appear in the statement above is critical;
they must be specified in exact order as
originally created by the VisualAge for Java

tools. Use the findByKeySQLString refer-

enced above to ensure correct ordering.
7. Save all changes.

Next focus on the EJB’s business logic. To
add new business methods, select the
EmployeeBean class and then choose Add ->
Method from its pop-up menu. For this exer-

cise, add:

After defining the new method, promote it
to the bean’s remote interface by selecting Add
to == Remote Interface from the new method’s
pop-up menu.

Setting descriptor properties and
generating deployed classes

Now that the EJB is defined, attention must
be turned to one additional task. An EJB

provider must include a deployment descriptor
for each EJB to describe the quality of services
a bean requires from its container. A deploy-
ment descriptor is a serialized instance of a
javax.ejb.deployment.EntityDescriptor or
javax.ejb.deployment.SessionDescriptor object.
In a nutshell, a deployment descriptor
describes the basic level of services, such as
environment, transaction, isolation and security
functions, that an EJB requires from a contain-
er. There is no need to change any of the
deployment descriptors in this exercise. The
default properties associated with the Employee
EJB can be viewed by right clicking the
Employee EJB in the EJBs pane and then
selecting the Properties menu item in the pop-
up menu. The Properties menu is shown in
Figure 4.

After fully defining the EJB and viewing
the deployment descriptor properties, deploy-
able code must be generated. To do this, right
click the Employee bean in the EJBs pane
and select Generate -> Deployed Code. The
EJB utility Generate -> Deployed Code gen-
erates types in the form EJSxxx, where xxx
is the type name — these types are specific
to the WebSphere Enterprise Java Server
(EJS) container.

Testing EJBs within the VisualAge for
Java EJB Development Environment
Before exporting an EJB and deploying it
into a container and EJS outside the
VisualAge for Java environment, VisualAge for
Java provides a self-contained Web applica-
tion server (WAS) within its environment for
testing and debugging. First ensure that the
DB2 database servers are started (net start
db2 and net start db2das00). Then return to
the VisualAge for Java EJB development envi-
ronment and right click on the
IBM_Sample_DB_EJBs group from the EJBs
pane. Select Add to -> Server Configuration
from the pop-up menu to launch the EJB
~ Server Configuration utility.

To start the servers, first view and
modify any communication and database
properties that may need changing (there is a
Properties menu item in each server’s pop-up
menu). Start each of the servers in the following
order, waiting for a “server is listening” message
before starting the next server:

1. Location Service Daemon

2. Persistent Name Server
3. EJB Server (Serverl)

/<,| Column Editor
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Figure 3. Associating fields with columns

When all three servers have successfully
started and are listening, go to the EJB Server
Configuration window and expand the EJB
group on the right to expose the Employee
EJB. Right click the Employee EJB and select
Generate > Test Client from the pop-up menu.
Then, run the test client by selecting Run Test
Client, which also is found in the EJB’s pop-up
menu. When the Employee test client appears,
establish a connection to the EJS name server.
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package com.ibm.sdm.demos;
import java.rmi.*;

import java.util.*;

import javax.naming.*;

import javax.ejb.*;

import com.ibm.sdm.sampledb.* ;

public class EmployeeClient {
public static void main(String args[])
{
String primaryKey = "000340" ;
try {
Properties p = new Properties();
p.put(Context.INITIAL_CONTEXT_FACTORY,
"com.ibm.jndi.CosNaming.CNInitialContextFactory");
p.put("java.naming.provider.url",
"iiop://ebafsrv.austin.ibm.com:9019");
InitialContext ic = new InitialContext(p);
System.out.println("initial context created") ;

Object tmpObj = ic.lookup("Employee"); //: JNDI name
EmployeeHome employeeHome =

EmployeeHomeHelper.narrow((org.omg.CORBA.Object)tmpObj);
Employee employee = null;
employee = employeeHome.findByPrimaryKey

(new EmployeeKey(primaryKey));

System.out.printin(“Employee found”) ;
} catch(Exception exception) { exception.printStackTrace() ;

Listing 1. Testing the bean

When the connection is established, you are
ready to test your new create, finder and busi-
ness methods.

Figure 5 reflects a few methods and fields
that were not added during the exercise above.

Deploying EJBs in WebSphere
Application Server 2.0 Advanced

When the new EJB has been fully tested in
the VisualAge for Java environment, the next
step is to deploy the bean in a fully functional
EJS environment such as WAS 2.0 Advanced.
VisualAge for Java gives you a few choices for .
exporting the EJB code, and two of those are of
interest to developers. One choice for exporting
is to generate an EJB jar file for immediate

deployment into a container provided by WAS

file SmartGuide that appears,
specify the location and name of
the new jar file as:
x/WebSphere/AppServer/
DeployableEJBs/Employee.jar
where X is the drive on which
IBM WebSphere Application
Server 2.0 Advanced has been
installed.

Next, from within a Web
browser, link to the WebSphere
Application Server
Administration pages found at
http://localhost:9527. Log in and
go to the Enterprise Java Services
page as seen in Figure 6.

From this page, link to three
other pages of settings that need
to be modified to deploy the new
Employee EJB in WAS:

EJS global settings
*  Enable EJS radio button is
Yes.
EJB Server Name is Serverl.
Protocol is CORBA.

Host Name is the machine’s host
name.

Use the default on the others.

EJS containers

Select the defaultEntityContainer
and add the information needed to
make a JDBC connection to the
SAMPLE database.

Delete any empty containers (such
as the defaultSessionContainer) as
JNDI queries to LDAP tend to fail
in WAS when empty containers

are found.

and running in a WAS/Universal DB2/LDAP EJB jar files
environment. The other option is to generate a + Deploy the Employee.jar file into

generic EJB jar file that can be deployed in any
other EJB container running in a Web server’s "
EJS. In the second scenario, the other contain-
ers have to provide a set of tools for viewing or

modifying the EJB’s deployment description

and for mapping the EJB’s container-managed

fields to an underlying datastore. For simplicity,

let’s export an EJB jar file specifically tailored
for the WAS environment. To do this, right
click the Employee bean in the EJBs pane of
the EJB development environment in the
Workbench and select Export > EJS Jar from
the pop-up menu. In the Export to an EJS jar

the defaultEntityContainer

The developer is prompted to regen-
erate files (re-create all the existing
WebSphere-specific files) or to rede-
ploy existing files (use what has
already been generated and simply
copy files and resources to the appro-
priate subdirectory). In this example,
choose to redeploy existing.

If successful, stop and re-start the
WebSphere Application Server. To
do this, go to Start -> Settings ->
Control Panel -> Services and

Enter the JNDI name for BeanHome:

Transaction Attribute: | TX_REQUIRED

Isolation Level: | TRANSACTION_SERIALIZABLE ~]

RunfsMode: [SYSTEM_IDENTITY =]

[~ Reentrant

[ ok | cane |

Figure 4. Viewing the beans properties

:C,’ Employee

Page Home interface

Methods: Send IParamelevs.

create(Employeekey)
create(EmployeeKey, String, Character, Strir
findByDepartment(String)

20000

findByPrimaryKey(EmployeeKey)
remove(Handle) :: EJBHome
remove(Object) :: EJBHome
getEJBMetaData() - EJBHome

K s | i
Result

Messages:

0] (double) =

=

INSpesty FeIore

Atternpting to connect to naming services. Please wait
Attemnpting to find an instance of the EJB home.
An instance of the EJB home was found.

=
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D introduction
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~ B3 Enterprise Java Services.
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Figure 6. Enterprise Java Services page
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locate the HTTP server and WebSphere

Servlet services.

To test the bean, run a minimal Java appli-
cation as shown in Listing 1. Before compiling
and trying to execute the test client, ensure
that X:/WebSphere/AppServer/lib/EJS jar and
X:/WebSphere/AppServer/DeployableEJBs/
Employee.jar are in the classpath.

To compile the sample, use

javac -d .EmployeeClient.java and to
invoke the application, use java
com.ibm.sdm.demos.EmployeeClient. The
application should display the “Employee
found” message.

Deploying EJBs in Component
Broker 2.0 Beta
One of the most important reasons for
building object-oriented applications with EJBs
is the promise of Write Once, Run Anywhere.
While the Sun EJB 1.0 specification is still
vague about API contracts between container
providers and EJS providers, it is possible to
build EJBs that can be deployed into any con-
tainers that conform to the minimal specifica-
tions and that provide the required level and
quality of services. As an example, IBM cur-
rently has a second EJS, Component Broker
2.0, in a limited beta. Component Broker 2.0
supports two programming models including its
own Managed Object Framework (C++ and
Java) and the EJB programming model.
Component Broker ships with a comprehensive
set of solutions for building and managing dis-
tributed objects:
Component Broker Connector
*  Extends enterprise software capabilities
* Enables transparent client (Java, ActiveX,*
and C++) access to multiple servers
* Manages throughput and response time
* Monitors availability and reroutes workflow
* Integrates new applications with existing
applications and middleware
* Manages for efficiency, control, and availability
Component Broker Toolkit
* Absorbs complexity in development of dis-
tributed, object-oriented applications
* Automates design and code generation
using a well-defined programming model
* Uses visual building processes and inte-
grates with popular object-oriented analysis
and design tools

* Includes distributed, object-aware debugger

When Component Broker 2.0 becomes gen-

erally available in the future, it should provide

a robust set of services and tools to manage

enterprise-wide, mission-critical distributed

applications. Component Broker 2.0 Beta pro-
vides a suite of tools to wrap existing EJBs as

Component Broker managed objects and to

deploy them into the Component Broker run-

time. These tools may include:

+ Jjetace: Used to assist in creating and/or
editing of an EJBs environment properties
and deployment descriptor

*  cbejb: Used to generate and build the C++
and Java code necessary to run the EJB in a
Component Broker environment

*  Object Builder utilities: Contains schema
and table mapping utilities for binding to a
datastore

+ PAOtoEJB: Used to associate CICS® or IMS
PAA services with an EJB server

*  ejbbind: Used to bind an EJB’s JNDI name
to a Component Broker namespace

However, as mentioned earlier, Component
Broker 2.0 is still in beta and there are a num-
ber of restrictions on deploying EJBs into a
Component Broker environment today. As an
example, the Employee EJB with container-
managed persistence fields created above would
not convert to the Component Broker managed
object framework without a number of signifi-
cant changes due to the following current
Component Broker restrictions:

*  The EJBMetaData interface is not
implemented

* The following methods are not supported
by Component Broker:

— EJBObject.getPrimaryKey,

— EJBHome.remove(Object) and

— EJBHome.getE]JBMeta Data (these

methods require object-by-value support)
* Finder methods that return collections of

()l)jects are not supported
* The primary key class of an entity bean must

be a primitive type or java.lang.String.

Of course, developers who want to deploy
EJBs into a Component Broker run-time could
develop EJBs with these limitations in mind for
now. As Component Broker matures, many of

these restrictions could be lifted.

Summary

So what is in the future for EJB integra-
tion with IBM software? While nobody can
predict the future, a number of IBM software
brands have stated directions that EJBs are a
central component of their strategy.

IBM recognized the importance and power
of EJBs in creating common, unifying pro-
gramming across its software application pro-
gramming interfaces. We can expect to see
other IBM and non-IBM products EJB-
enabled in the future. To track and keep up
with the latest IBM software product plans,
visit www. software.ibm.com and

www.developer.ibm.com frequently.

Mickey Nix is a Senior Programmer with the
IBM Solution Developer Marketing organization
in Austin, Texas. In his role as a network com-
puting consultant, Mickey assists IBM’s top inde-
pendent software vendors in their efforts to
migrate their mission critical applications to
Web-enabled platforms using IBM’s middleware
and servers. For the last year, Mickey also has
taken on the additional responsibility of IBM

SanFrancisco Frameworks consultant.

Editor’s Note: The sample code included in this article
can be downloaded from the Developer Connection
Web site at www.developer.ibm.com/devcon/. The

code also is available on the July CDs.




Deploying VisualAge for Java

Enterprise Beans to the
WebSphere Application Server

by Howard

Borenstein

“he IBM VisualAge
for Java product pro-
vides a powerful and
productive environ-
ment in which to develop enterprise beans. It
includes tools to help create and organize
enterprise beans, and it features an IBM
WebSphere Application Server environment
that allows developers to completely unit test
the code. Once the beans have been created
and tested in VisualAge for Java, they can be
deployed to an EJB-compliant server.

This article shows how to take enterprise
beans that are developed using VisualAge for
Java, Version 2.0 with the Enterprise Update, and
deploy them to the WebSphere 2.0 Advanced
Application Server. The article assumes that
WebSphere is installed on the Windows NT plat-
form, but the information also applies to
WebSphere installations on the AIX* and Solaris
platforms, except for the starting and stopping of
the WebSphere Servlet Service.

Exporting your beans

The first deployment step is to export the
beans into a JAR file. There are two types of
JAR files that developers can create: an EJB
JAR file, and a deployed JAR file. An EJB
JAR file contains the bean code (bean, home
interface and remote interface), but it does
not contain the deployed classes required to
run the bean on an EJB server. When deploy-
ing an EJB JAR file to the WebSphere
Application Server, it generates the necessary
deployed classes.

The recommended way to export beans is
to create a deployed JAR file. This JAR file
contains the bean code and the deployed class-
es. When deploying this JAR file to the
WebSphere Application Server, it recognizes
that the deployed classes already exist and it
does not have to regenerate them. If any entity
beans are mapped with the VisualAge for Java
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Persistence Builder, then a deployed JAR file
must be used to prevent WebSphere from re-
creating the deployed classes.

On the EJB page in VisualAge for Java,
select an EJB group or one or more enterprise
beans, then select the Export menu on the item’s
pop-up menu. Then, choose whether to export
the beans in an EJB JAR file or in a deployed
JAR file, by selecting EJS JAR. The Export
SmartGuide is shown in Figure 1. The developer
may export entity beans and session beans in the
same JAR file; however the JAR file would need
to be deployed into both an entity container

and a session container.

IBM DB2 driver db2java.zip also must be
specified on the classpath.

+  properties\server\servlet\debug.properties
This file enables the tracing capability. This
is invaluable when first getting started with
the WebSphere server. Trace output can be
directed to either the WebSphere console
or to a file. Tracing to a file is probably the
most convenient way of directing output.
For enterprise beans, tracing can be

enabled for the EJS trace group by specifying

the following parameters:

# EJS Trace Group : :
trace.group.ejs.tracers=EJS_stdout EJS_stderr LSD_stdout

Setting up the WebSphere e LSD_ stderr PNS..—WQPNS_ e
Application Server trace.group.ejs.state=on
trace.group.ejs.handlers=LogFile

There are three files you must config-
ure before using enterprise beans in the
WebSphere server. The appropriate settings
may be accessed through the WebSphere
Administration Ul or by editing the files. Direct
editing of the files is the most efficient means
of configuring the files.
+  properties\bootstrap.properties:
This file contains the setting java.classpath
for setting the classpath of the server. If the
enterprise beans use any support classes or

call any Java code outside the bean, then

you must add the location of the code (or
the JAR file containing the code) to the
java.classpath setting. The location of the

The IBM
VisualAge for
Java product provides

a powerful and productive
environment in which to
develop enterprise

heans.
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When tracing is enabled, the output files are
created in the logs directory. The files needed
are websphere_trace.log and jvm_stderr.log. All
of the tracing of the server is placed in web-
sphere_trace.log. This is similar to the output
seen in the Console window. shown in Figure 2.
when using the VisualAge for Java EJB server.
This file is appended to each time the server is
started, so delete the file periodically. The
jvm_stderr.log file contains the output generated
when deploying a JAR file into a container. This
file is re-created each time the server is started,
so ensure that the contents are checked after
deploying a JAR file, but before restarting the
server.

+  properties\ejs\ejs.properties

This file contains all of the configuration

information for the EJB server. There is a

line “containers="that lists all of the con-

tainers in the server, and there also is a sec-
tion for each container. Some things you
need to configure include:

— ejs.trace.enabled — Set this to true for
more detailed tracing. It may not be
needed, but it is helpful if you are hav-
ing trouble getting things working.

— nameservice.hostname — The default
value is localhost. To access beans from a
client on a remote machine, change this




value to the name of the server machine.
Using the following parameters, specily the
name of the database to use for any entity con-
tainers, as well as the username and password
used to access the database:
- defaultEntityContainer.dbUrl=jdbc:db2:sample

~ defaultEntityContainer.dbUser=howard
- defaultEntityContainer.dbPassword=abc

l If any containers do not have JAR files
deployed. remove them from the containers=
line. If there is an empty container, exceptions

) may be thrown when the EJB server is started.
By default, the defaultSessionContainer is

empty, so it should be removed for now.

Deploying your beans

Once you are finished setting up the
WebSphere server, deploy the JAR files into
the containers using the Administration Ul
Copy the JAR files created in VisualAge for
Java into the deployableEJBs directory. Make
sure that any classes the bean uses are specified
on the classpath as discussed above, then start
the Web server. For example, if the Web server
is Lotus Domino Go, then start the Lotus
Domino Go Webserver service from the
Windows NT Services panel.

Load http://machinename:9527 in your
browser, then navigate to the Enterprise
Java Services - EJB Jar Files page shown in
Figure 3. Select the JAR file from the list of
JARs. In the beans panel. you should see a
list of beans. If the error message
“java.lang. NoClassDefFoundError” appears,

then the server’s classpath is missing some

classes necessary for one of the jar files in the
deployable EJBs directory. The server will
need to be restarted if any changes are made
to the classpath.

If the JAR file contains entity beans, select
an entity container and then select Deploy. If
deploying a deployed JAR file, a dialog box
should open. Select Redeploy existing. If
deploying an EJB JAR file, it takes some time
for the deployed code to be generated. In both
cases, the last step of the deployment process is
to create the database tables. A message box will
indicate the success or failure of the deploy-
ment process.

At this point browse the jvm_stderr.log file
for any errors reported during deployment or
the creation of the database tables. If the
tables already existed, you will see the follow-

mg (‘XC(‘I)[]()II:

COM.ibm.db2 jdbc.app.DB2Exception: [IBM][CLI Driver][DB2/NT]
SQLO601TN The name of the object to be created is identical to the
existing name "EJB.MYBEAN" of type "TABLE".
SQLSTATE=42710

This exception can be ignored. Check |
the ejs.properties file and ensure that the
Jar file was added to the following
JarFiles line:

defaultEntityContainer.jarFiles=Inc.jar,mybeans.jar

The JAR file also should have been
copied to the deployedEJBs directory.

If using a deployed JAR and the data-
base tables already exist, you do not need to
use the UL Just manually add the JAR file to
the jarFiles entry. Similarly, deploy any JAR
files with session beans to a session contain-
er. If the JAR was deployed to a container
that was removed from the containers line
because the container was empty. be sure to

add it back before starting the server.

Starting the server

After deploying a JAR file into a contain-  [§

er, stop and restart the server in order to use
the enterprise beans. Stop the Web server

7

SmartGuide

What do you want to include in the jar fle?
¥ beans Detais... | 2 selected ‘
7 gess  Detak.. | 30selected 4
I~ java Detarls), 30 selected
[ resouce  Detais.. | 0selected

—_—

Sdedrdaermdtpsmdweul

Options

¥ Include debug attributes in .class files.

v Compress the contents of the jar file.

[~ Dvewrite existing files without warming.

™ Automatically open a web browser on created _html files.

Figure 1. Export SmartGuide

Console BEE

Fle Edt Workspace Programs Window Help

and then stop the WebSphere Servlet
Service from the Services panel, then restart
the Web server. To ensure that everything is
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operating properly, check the
websphere_trace.log file. If the
ejs.trace.enabled property in ejs.properties
did not change, then the last two lines in the
file are:

[EJS_stdout,1] server E Server is listening...
[EJS_stdout,1] Nameservice D Local namespace:

: ibm.ejs. server. ServerddminInter s
00007ac9 EJSLocalConte E bindl’.ﬂoully. false
00007acS EJSLocalConte < rebind

_ admin
00007acy server E Server is listening...
00007ac9 Nameservice Local namespace:

D
00007ac9 EJSLocalConte D bindings:
{Inc=con.transarc.jnon.exanples.Inc. —
|

of

Figure 2. Console Window output

37 1BM WebSphere Application Server Adml!\lslldll(\n Netscape

Fle Edt View Go C

If ejs.trace.enabled was changed to 1
true, the last message should be a bindings

message listing the beans in the container.

iéaﬁaﬁdiﬁ P

[Pttp:77bkueiny-9527 /admin/web himi ~

EJB Jar File Information and Deployment

This is similar to what is seen in the ’gg':‘z:"‘“"" # blujay
. : . Ready
VisualAge for Java console when running » O3 Seviets -
> =} v () Enterprise Java Senvices e
the EJB server. Bgau:a! Seftings Sagiag] [ coarries |2 o
ontainers 7S
f Java exceptions are seen in the log, DEJB Jar Files | Amaseseriar ! -
I 'l‘T\d Xcef > 8 ) = b} » £ Securiy Mndeploy EmployeeServer jar Jar File Name: | exportjar
try to diagnose the cause and fix them. If a » 03 Server Execution Analysis Helloerver jar s Delest
) g -~ pp Beans Defined in Jar
N . . ” . 09 !
No suitable driver” message is shown, the g Sean |
SimpleServer jar e
cause could be one of the following: StockServer jar PigMert 23T ohesnEe gy
- N ) . ) = exportjar pkgMar1 2. MySessBeant
* The db2java.zip file is not on the class- pkgMar! 2 MyBeanBean
ITSOEJS jar
path. i
. K1} | >|
* A wrong username or password is spec- @G I SIS N @D NS
ified in the (’".\'.l)l‘()pt’l'lll‘ﬁ file. Flgure 3. Enterpr/se Java Se,’v/ces e
+  Change the WebSphere Servlet Service EJB Jar Files page

to run as a user with database access. To
change the configuration of the WebSphere
Servlet Service, open the Windows NT
Services window from the Control Panel.
Click Startup and change the Log in as value
to This account, then add the username and

password used to access the database.

Testing your beans
Use the generated Test Client in VisualAge
for Java or your own test client to test the beans
as shown in Figure 4. The default port of the
Persistent Name Server in WebSphere is 9019, so
change iiop:/// to iiop://machinename:9019 in

CONTINUED ON PAGE 18




CONTINUED FROM PAGE 17

JNDI name: | Inc

Provider URL: I iiop:fbluejay.9019

Initial context factory; | com.ibm jndi.CosNaming.CNInitialContextF actory

Home interface: | com.transarc. jmon.examples.Inc.IncHome
Home helper: | com transarc.jmon.examples.Inc.IncHomeHelper

Connect I

Messages:

Figure 4. Test client generated

the VisualAge Test Client. If the enterprise beans
are not working as expected, browse the web-
sphere_trace.log file for any run-time exceptions.
Conclusion

To successfully deploy enterprise beans to
the WebSphere Application Server, there are
many configuration steps the developer must
take to enable an EJB environment, as well as
several files that need to be checked to see if
the deployment and EJB server startup was
successful. However, because VisualAge for
Java contains the same WebSphere runtime as
the WebSphere Application Server, developers
can feel confident that the run-time behavior
experienced is the same in the WebSphere
environment as it was in the VisualAge for Java

environment.

Howard Borenstein is a Software Developer at
the Toronto Lab, IBM Canada Ltd. He has been
developing application development tools for
eight years, and he currently works on the
WebSphere tools in the VisualAge for Java
product. He can be reached at
borenst@ca.ibm.com.
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a scalable, Build
available, safe _ new
environment applications

IBM, NINTENDO
ANNOUNCE

$1 BILLION
TECHNOLOGY
AGREEMENT

IBM AND NINTENDO HAVE ANNOUNCED A MULTI-YEAR $1 BILLION TECHNOLOGY
AGREEMENT TO SUPPORT NINTENDO’S NEXT HOME VIDEO GAME CONSOLE, CODE=-
NAMED ‘DOLPHIN.

AS PART OF THE AGREEMENT, IBM WILL DESIGN AND MANUFACTURE A UNIQUE
400 MHz CENTRAL PROCESSOR FEATURING IBM’S INDUSTRY-LEADING 0.18
MICRON COPPER TECHNOLOGY. THE CHIP, DUBBED THE ‘GEKKO’ PROCESSOR, IS
AN EXTENSION OF THE IBM PoweRPC ARCHITECTURE. IT’S DESIGNED TO BE
MORE POWERFUL THAN THOSE FOUND IN ANY CURRENT OR PLANNED HOME VIDEO
GAME ENTERTAINMENT SYSTEM, PROVIDING PLAYERS WITH DRAMATICALLY BET-
TER GRAPHICS AND MORE REALISTIC ACTION.

THE PROCESSOR IS IN THE ADVANCED STAGES OF DEVELOPMENT, SUPPORTING
NINTENDO’S PLANS FOR A WORLDWIDE LAUNCH FOR THE 2000 HOLIDAY SEASON.

solutions



Implementing Enterprise JavaBeans in AIX 4.3.2

THE ENTERPRISE JAVABEAN (EJB) SPECI-
FICATION DEFINES A MODEL FOR COMPO-
NENT-BASED DISTRIBUTED COMPUTING. IT
DEFINES A CLEAR SEPARATION OF BUSINESS
LOGIC AND PERSISTENT, TRANSACTIONAL
SUPPORT AND OTHER MIDDLEWARE-RELATED
SERVICES. SOLUTION DEVELOPERS CAN
CONCENTRATE ALL THEIR EFFORTS ON
DEVELOPING THE BUSINESS LOGIC AND
LEAVE THE MIDDLEWARE-RELATED TASKS TO
THE EJB CONTAINER IN WHICH THE EJBs
ARE DEPLOYED.

AN EJB CAN BE TRANSIENT (SESSIONBEAN),
WHICH MEANS IT IS CREATED BY AN APPLICA-
TION AND LASTS ONLY AS LONG AS THE APPLI-
CATION IS RUNNING; OR PERSISTENT
(ENTITYBEAN), WHICH MEANS IT IS WRITTEN
OUT TO PERMANENT STORAGE (USUALLY A
RELATIONAL DATABASE) AND CAN BE
ACCESSED IN THE FUTURE.

APPLICATION SERVERS ARE A MAJOR PART
OF THE FRAMEWORK FOR DEVELOPING E-
BUSINESS APPLICATIONS. TO BE EFFECTIVE
WITH ENTERPRISE JAVABEANS, AN APPLICA-
TION SERVER SHOULD INCORPORATE A MUL-
TITUDE OF FUNCTIONS. THESE INCLUDE DATA-
BASE ACCESS, TRANSACTION SUPPORT, COM-
PONENT FUNCTIONALITY AND, OF COURSE,
WEB FUNCTIONALITY AND CAPABILITIES.

THE TECHNOLOGY OF ENTERPRISE

JAVABEANS IS NOT LIMITED TO THE AIX
PLATFORM. THIS TECHNOLOGY DEFINES A

MODEL THAT SUPPORTS THE “WRITE ONCE,
RuN ANYWHERE®” SUPPORT FOR THE EJB
MODEL, AS THE MEANS BY WHICH APPLICA-
TION SERVICES AND APPLICATION SERVER
INTEGRATION ARE PROVIDED ON THE SERVER
TIER. THIS MEANS THAT JAVA IS THE LAN-
GUAGE, AND JAVABEANS ARE THE COMPO-
NENT MODEL.

However, THE NEw RS/6000* SERVERS
ARE THE PERFECT SOLUTION TO TAKE ADVAN-
TAGE OF THE ENTERPRISE JAVABEAN MODEL
BY PROVIDING THE SERVER TIER, WHICH CON-~
SISTS OF APPLICATION SERVICES, AND ONE
OR MORE APPLICATION SERVERS BECAUSE OF
THEIR INDUSTRY-LEADING DECISION SUPPORT
PERFORMANCE.

THE IBM SUITES FOR E-BUSINESS PROVIDE A
WEB APPLICATION SERVER. THE WEBSPHERE
APPLICATION SERVER IS AVAILABLE NOW FOR
DEVELOPERS ON THE AIX PLATFORM. IT
ALLOWS DEVELOPERS TO TAKE ADVANTAGE OF
THE ENTERPRISE JAVABEAN PORTABILITY.
WEBSPHERE APPLICATION SERVER
ADVANCED EDITION AND THE ENTERPRISE
EDITION INCLUDE SUPPORT FOR ENTERPRISE
JAVABEANS. THE ENTERPRISE EDITION
INCLUDES RELATIONAL DATABASE CONNEC-
TIVITY AND SUPPORT FOR JAVA TRANSACTION
SERVICES. ENTERPRISE JAVABEANS FOR
CONNECTING TO MQSERIES, CICS AND
OTHER TRANSACTIONAL ENVIRONMENTS ARE
EXPECTED FUTURE ENHANCEMENTS.

VISUALAGE FOR JAvA VERSION 2.1
ENTERPRISE EDITION PROVIDES THE CAPA-
BILITY TO DEVELOP ENTERPRISE JAVABEANS
AS WELL AS OTHER ENTERPRISE APPLICA-
TIONS THAT CAN BE DEPLOYED ON THE
WEBSPHERE APPLICATION SERVER. THIS
SUPPORT IS PART OF AN INSTALLABLE FEA-
TURE CALLED IBM ENTERPRISE JAVA
SERVER (EJS) WHICH CONTAINS:

+ AN IMPLEMENTATION OF THE JAVA WEB
SERVER AND JAVA SERVER TOOLKIT THAT
PROVIDES JAVA SERVER PAGES (JSP)
AND JAVA SERVLET SUPPORT.

» AN IMPLEMENTATION OF AN ENTERPRISE
JAVA SERVER (EJS) AND A SET OF EJB
CONTAINERS THAT ALLow EJBs TO
ACCESS RELATIONAL DATABASES.

» SUPPORT SERVICES, SUCH As JNDI,
CORBA CosNAMING SERVICES, AND
ADMINISTRATION AND DEPLOYMENT TOOLS
TO OPERATE THE SERVER AND MANAGE
EJBs, SERVLETS, AND JSPs.

THE VISUALAGE TOOLKIT PROVIDES A POW-
ERFUL SET OF TOOLS TO CREATE E-BUSINESS
APPLICATIONS THAT ALLOW DEVELOPERS TO
RAPIDLY DEVELOP DISTRIBUTED APPLICA-
TIONS THAT RUN ON A WIDE VARIETY OF
CLIENT AND SERVER PLATFORMS.

TAKE ADVANTAGE - TAKE YOUR BUSINESS TO
E-BUSINESS.




by Mark Wulf

usiness
Intelligence may seem
like an oxymoron.
How many businesses
do you know of that
actually take advantage
of the “intelligence”
that they have available? Many of our customers
don’t understand the value of the intelligence
they have in their businesses.

Business Intelligence (BI) is simply using
information that a company has, to make better
business decisions. As suppliers of technology
and solutions to customers, IBM can play a
major role in helping customer businesses
become intelligent and creating more competi-
tive offerings ourselves.

The AS/400, as well as all of the IBM
servers, can play a key role in the addition of
BI to your applications.

The AS/400 and its business partners have
long been known for delivering solutions to its
customers. The Bl market is no exception to
this strategy. IBM is actively working with its
business partners to add Bl as part of the solu-
tion they can offer their customers by pairing Bl
technology providers with vertical industry
application providers.

The BI technology providers sell things like

OLAP and data warehouse management tools

or query and report writers that are the basis
for many Bl solutions. The vertical industry
application providers have knowledge about
what information their customers need to run
their businesses. Working together, these two
providers can create a Bl solution that requires
a very small investment to develop while creat-
ing great market advantage.

Many application providers are taking
advantage of these new partnerships to sell
more products to their installed base of cus-
tomers while being able to compete more effec-
tively for new customers.

Many of the AS/400 BI technology
providers are using this strategy to provide
more solutions and reach many more cus-
tomers then they could by themselves.

Many AS/400 BI technology providers have

been hard at work integrating their products

Business Intelligence

with IBM Visual Warehouse.® This integration
will allow these products to exchange meta data
with other products. Definitions created in one
product will be available in other products and
there is no need to duplicate work or identify
pieces of information multiple times. Using
multiple products in a single implementation
becomes much easier when the meta data can
be defined in one product and used by the rest

of the products.

New technology

Two new technology providers have recent-
ly made the decision to make their products
available on the AS/400. The first is SPSS, Inc.
SPSS is known for advanced data analysis
products using statistical analysis and data min-
ing technology. Their products are a great com-
plement to the capabilities of IBM Intelligent
Miner and supplement the ability of AS/400 to
provide a wide spectrum of data analysis tools.

The second company is Viador. Viador pro-
vides products to create Web-based information
portals. These portals can provide information
to hundreds if not thousands of users through a
browser interface. Each user experience is cus-
tomizable and information can be provided
through query tools or report writers that come
with the product or come from almost any other
source of business intelligence information.
These portals are the latest technology in pro-
viding information to many users who might not
have the skills or the desire to learn one of the
traditional Bl tools.

The AS/400 team has recently announced
many new capabilities that make it an even
better system to host BI or traditional applica-
tions. The most important announcement was
the addition of Universal Database (UDB)
enhancements to DB2 for AS/400. (See DB2
UDB on page 6.) With these enhancements
comes an AS/400 database name change —
from DB2 for AS/400 to DB2 Universal
Database for AS/400.

A new feature: EVis

One of the major new features that was
shipped in V4R3 and is undergoing additional
usage in V4R4 is Encoded Vector Indexes (EVIs).
EVIs are a new type of index developed and
patented by the IBM Thomas J. Watson Research
Center. They are used much like traditional

indexes are used today (to provide fast ways to
find specific rows in a database
table), but have effi-
ciencies

that traditional
indexes do not.

These efficiencies come in part from
the fact that EVIs are up to 16 times smaller
than a traditional index. This means less [/0 is
required to get the EVI into memory and more
EVIs will fit into memory. The size of the EVIs
make it faster to scan for key values or to create
other data structures used to resolve a query.

These data structures, which are actually bit
maps, can then be combined together very sim-
ply to solve more complex queries. The effect is
that multiple EVIs can be used in conjunction
to solve a single query. The ability to use multi-
ple EVIs reduces the database administrator’s
need to create the perfect single traditional
index for each query.

These new indexes are having major impact
on the performance of customer implementa-
tions. Many customers are reporting up to 30
times better performance on their longest run-
ning queries.

Summary

Whether the AS/400 is delivering solutions,
new technologies from our partners or deliver-
ing database functions that can have enormous
impact on the performance of a Bl implemen-
tation, the AS/400 is ready to be part of adding

intelligence to any business.

Mark Wulf is the Business Intelligence Segment
Manager for AS/400 Partners in Development.
His group is responsible for the recruiting and
technical support of AS/400 Business
Intelligence Solution providers. Mark also man-
ages the AS/400 Teraplex Center. The AS/400
Teraplex Center was started to help customers
and business partners implement multiterabyte
data warehouses on the AS/400. Mark has been
at IBM 10 years and worked in DB2/400 devel-
opment prior to joining the Partners in
Development organization. Mark's roles in
DB2/400 development included lead developer

for Distributed Data Management, Distributed

Relational Database, Commitment Control and

ODBC. His last role in development was as
Chief Data Warehouse Architect for the AS/400.
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Java on OS/390
elivers real portability

by Mark Cathcart

" ava delivers cross-
platform portability like
nothing before it! For
S/390, both 0S/390
and VM/ESA provide
implementations of the
Java Virtual Machine (JVM) that are compati-
ble with the 100% Pure Java initiative. This
article looks at portability and Java, gives an
overview of the JVM. and outlines the plans
and strategy for Java on 0S/390.

Portability concerns

Just a few years ago, the computer industry
model of portability came in two flavors, both
of which had problems:

* Source code portability in UNIX* systems
* Reuse of business objects

Source code portability depended on the
availability of much more than just the UNIX
application programming interfaces (APIs). It
depended on vendor products, run-time
libraries and an identical implementation of
tools and utilities that were not part of the core
UNIX standard.

Reusable business objects usually were
implemented through program language source
code files. Thus, porting objects had the same
problems as porting UNIX applications. True,
for some object or component technology,
portability depended on a definition. But the
portability of the definition was restricted by
the availability of tools to understand the defin-

The ability
to package and execute

a common, industry-standard
program format has made the
portability of Java programs

an industry-leading
technology.

ition. While part of the IT industry was trying
to work around these problems, others were
looking for a technology that would allow the
distribution of executable, component-based
technology over the Internet. In order for this
to be a commercial success outside of the acad-
emic world, the technology needed to allow
programmers (o:
* Build/model business and technology in

components
* Package those components as executable

code
*  Make the code available via networks for

use on many different computer systems

For a short time, many people thought that
the only solution was Windows everywhere. It
became apparent, however, that Windows wasn’t
the answer either. The functional differences
between “palmtop™ and true server computing
simply were too great.

Java to the rescue

Java provides a completely different
approach to portability. It does not need or
require language source code portability.
Instead, Java provides a common execution
environment — the Java Virtual
Machine - across a number of dif-
ferent environments, processors
and microprocessors and operating
systems. The Java Virtual Machine
is, in concept, a microprocessor
implemented in software.

The definition of Java archi-

and binary class byte-codes is packaged with an
extensive set of defined underlying classes. The
result is that Java programs can be moved at
the binary, byte-code level, knowing that a
100% Pure Java environment will provide
common run-time support.

Through support of reusable business
objects or components known as Java Beans,
Java also encourages the design and program-
ming of applications in small functional classes,
which implement only the business or technol-
ogy process logic. These can be packaged and
reused wherever it makes sense, irrespective of
platform or technology. Thus, the same appli-
cations can run on workstations, deparlmenlal
servers, midrange servers or enterprise servers.

Java basics

The ability to package and execute a com-
mon, industry-standard program format has
made the portability of Java programs an
industry-leading technology.

Figure 1 shows the Java Virtual Machine
and its relationship to the operating system and
hardware where you run Java. The diagram
illustrates the process from source code to exe-
cution. As shown, the first step is to compile

Java Virtual Machine

tecture is managed by Sun Micro-
systems, with input from others
in the Java arena, one of these
being IBM.

It is interesting to note that

Java also provides support for
component or object-based tech-
nology. This means that Java

addresses the primary portability
problems. The JVM runs a stan-
dard form of executable program.
commonly called byte-code. This
byte-code contains a binary class
structure that the JVM uses to cre-
ate and manage objects modeled in
software. This combination of JVM

Figure 1. Relationship of Java Virtual Machine

to the operating system and hardware

CONTINUED ON PAGE ¢



CONTINUED FROM PAGE 21

the source code, filename.java. This compila-
tion takes place inside the JVM, because the
Java compiler is a Java program that has been
compiled into byte-code.

The output from the compiler is a file-
name.class file. In order to run the .class file,
the JVM is started and given the name of the
class for the .class file, not the filename of the
.class file. The initial class is loaded by the
Class Loader.

As it processes a stream of byte-codes, it
sends them to the Byte-Code Verifier.

The Byte-Code Verifier makes a number of
checks on the structure and validity of the
byte-code and passes it to an Interpreter or to a
Just-In-Time (JIT) Compiler.

The Interpreter or JIT Compiler then exe-
cutes the instruction, which is directly processed
on the hardware processor or trapped by the
operating system and indirectly executed.

$/390 and Java

In an 05/390* or VM/ESA® system, the
JVM is implemented using the available UNIX
interfaces. Java source code is stored in the
$/390* UNIX file system and the JVM uses the
UNIX services. This means that 0S/390 and
VM/ESA customers can benefit from the porta-
bility of Java.

The remainder of the article concentrates
on the 0S/390 implementation of the JVM. On
05/390, well-structured and well-written Java
programs benefit from the fact that 0S/390
runs each thread within a Java class as a fully
pre-emptive, multi-tasked 0S/390 TCB (Task
Control Block). This means that multithreaded
Java programs — especially those that are
launched and then execute for extended peri-
ods of time — can benefit from extensive work-
load management and multi-processor, multi-
threading capabilities in 0S/390.

Why run Java on 0S5/390?

A question | often hear is: “Why run Java
on 05/3907” Currently, many people are
experimenting with Java, and a number of
large, well-known projects are being completely
written in Java. Because many of these projects
require integration and collaboration with
existing 0S/390-based applications and data-
bases, that, in itself, might be a good enough
reason. There may be a more compelling one,
however; it’s called payback.

As organizations drive more and more for
competitive advantage, they need to be able to

exploit the best, most current skills
and tools in the computer industry.

Java Environmental Structure

The past year has seen a massive i Java IDE, i.e.VisualAge
swing towards Java. I Java
A Gartner G tud ‘ cosiie Compiler
recent Gartner Group study . Applications | | P! o= el
showed that almost one-third of all 1 Sivan ‘ Applets I
students in computer degree courses : Java Environment API
chose to use Java as their primary Native Methods ]
. I .. Java Byte-Codes
programming language. In addition, R :
: . | ive Method:
many leading edge'r Integrated Machine (JVM) I | Native Methods K bistracions
Development Environments (IDEs)
. [ 0S/390
_— " |
for Java - such as IBM VisualAge for A s

Java - have arrived. Together. they
create an impressive opportunity that
would be foolish to pass up.

Companies can put new staff straight to
work using a programming language (and
potentially an IDE) that they are completely at
home with. Program development and local
testing of “standard™ Java byte-codes can be
done entirely in a workstation environment and
then deployed on the platform of choice. For
example, byte-codes can be uploaded, tested
and put into production on 0S/390 without
recompilation or changing a single line of code.
From a business perspective, this is an almost
irresistible combination.

There’s no reason to wait

Figure 2 shows the relationship between
the various components in Java and at what
level each technology exists. Tools such as
VisualAge for Java or 05/390 products them-
selves provide Java gateways or connectors that
allow 0S/390 Java programs to access back-
end, “native” systems. Examples of such sys-
tems are CICS, IMS and DB2. The 0S/390 edi-
tion of WebSphere Application Server also sup-
ports Java Servlets and JavaServer Pages (JSPs)
with the Common Connector Framework to
communicate with back-end systems.

In addition, offerings such as Host-On-
Demand provide low technology solutions for
interfacing to 3270 applications through an
API. Java-based solutions also are available for
ISPF, Tivoli Information Management, NetView
and a number of 5/390 services and subsys-
tems. If you are not familiar with the Java pro-
gramming language, you might be considering
this as a career enhancing skill. Yet be aware
that while it may be easier to program in Java
than it is in C or C++, it could be even easier.

The good news is that you can use one of
the existing skills you have - the ability to pro-
gram in REXX! With some additional reading,

solutions

Figure 2. Relationship between Java components

you can take those programming skills and
write in NetRexx*, which is compiled into Java
byte-code. This gives you all the benefits of
Java byte-code portability and system indepen-
dence, using a language in which many 0S/390
people have skills and which is much more
readable and maintainable. In fact, after three
years working in the object-oriented (00) field,
I've finally become hooked on OO program-
ming through NetRexx.

VisualAge for Java Enterprise Edition, also
is now available with a OS/390 Enterprise
Toolkit. The toolkit provides a native code
compiler that compiles Java byte-code into an
0S/390 DLL that can be used without the
JVM, a remote debugger, a performance profil-
er and JPORT, a porting utility. The Native
code-compiler is a key tool as it allows Java to
be used as a development language for envi-
ronments where the Java Virtual Machine cur-
rently cannot be used. The first supported envi-
ronment is CICS, where a developer now can
write CICS transactions using the JCICS classes;
next will be DB2 Stored Procedures and, at a
later date, mMs* mpp programs.

Performance

I often am asked about the performance of
Java programs. This concern usually stems
from the notion that Java byte-code is “inter-
preted” rather than compiled in the traditional
sense. But this really isn’t true any more. Even
if it were, a number of other changes have sig-
nificantly changed the performance profile of
Java. A complete makeover of the JDK in the
1.1.6 (December 1998 and April 1999 issues of
the Developer Connection Technical Magazine)
release has lead to significant improvements.

In general, the perception of Java perfor-
mance stems from the amount of time it initially



takes to load the JVM. If you have a trivial pro-
gram that only does something simple and then
exits, the time spent loading the JVM sometimes
exceeds the time to run the program.

For long-running, server-type applications,
the performance of Java is broadly similar to
COBOL. When comparing identical function,
that might mean an additional 20 percent over-
head, depending on the program. If using Java
as a procedural scripting language, then perfor-
mance has a different profile. It is less like
COBOL and more like interpreted REXX, again
depending on the program. In the future, addi-
tional planned changes should enhance and
improve Java performance on 0S/390.

What’s next?

In April 1999, a new version of JDK 1.1.6
was released. This is known internally as 116p,
and for the first time amongst other enhance-
ments it uses the 0S/390, industry-leading
WorkLoad Manager(WLM) to manage, schedule
and prioritize Java execution threads.

Next in plan is a 1.1.8 JDK, which is
expected to achieve another 2X performance
improvement and provide some significant
function back-ported from Java 2. These
include the Security, RMI over [10P, Swing
and other functionality.

An alpha implementation of Java 2 is
planned for late 1999. We will be assessing the
applicability to 0S/390 of the Hotspot Compiler
as it is developed by Sun. We continue to work
on incremental performance improvements,
while at the same time looking for major break-
throughs to make 0S/390 the industry’s leading
Java business transaction server.

In addition to the base JDKs, we also are
starting to ship specific 0S/390 class-packages:
JRIO, a set of record 1/0 classes that will pro-
vide access to Sequential, PDS and VSAM files
on 0S/390; RAWT, a set of Java classes that
replace the standard AWT classes. They turn
your Java AWT calls into a call from 0S/390 to
any Java client running the RAWT client class-
es, where the call is received and mapped into
local/client AWT classes. In this way, you can
write distributed AWT calls without having to
worry about the network communication.
RAWT does that. RAWT gives you the ability to
put distributed management consoles or moni-
toring into your 0OS/390 Java applications;
RACF* classes are the first step toward inte-
grating Java security with native RACF security.

05/390’s strategy is to ship new and updat-
ed JDKs when appropriate. If there is major
new Java function, then an 0S/390 implemen-
tation will be available. If there is no major
new function, then we will ship maintenance
releases. Not every maintenance release pro-
duced will be shipped, but quarterly or twice
yearly updates might be reasonable to expect.

We have seen the emergence of the
Enterprise JavaBeans specification as the server
infrastructure for Java components, providing
enterprise-class facilities such as transaction,
naming and directory services. The ability to
utilize and exploit this type of technology
through Java is paramount for an enterprise-
class solution and will be a natural extension of
the 0S/390 JVM and CORBA support in
Component Broker. In addition, Enterprise
JavaBeans will be available on 0S/390 through
the CICS Transaction Server for lean, mean
transaction beans, and also through vendor
products such as Bluestones” Sapphire/Web.
Other exploiters of Enterprise JavaBeans will be
the IBM WebSphere Application Server and the
Software AG Bolero Business Application Server.

Summary

The opportunity for your business to bene-
fit from Java is substantial. Its component
model encourages applications to be designed
and built to represent real business and tech-
nology processes. And the Java Virtual Machine
delivers on the ability to reuse these compo-
nents throughout your organization, irrespec-
tive of platform. With the planned and future
enhancements in Java performance, plus appli-
cation infrastructure support for Enterprise
JavaBeans, 0S/390 will provide a scalable, reli-
able, secure foundation for your enterprise-

class Java applications.

Additional information

To learn more about Java and 0S/390, a
detailed presentation on this topic, a short
05/390 programming workshop and sample
programs are on my Web site. Our first Java
redbook, Integrating Java for OS/390 with
Existing Applications and Data. is available in
printed format and from the Web as a PDF.
The IBM publication number is SG24-5142.
The second, e-business Application Solutions
on 05/390 Using Java Vol.1 SG24-5342, is
available from the Web now as a PDF. It is
planned to be available in printed format in
June 1999.

For more information, see:
*  www.ibm.com/s390/corner for Cathcart's
Corner for presentations, white papers and

SO on.

* www.ibm.com/s390/java for Official Java

0S/390 web site.

*  www.ibm.com/redbooks for redbooks on
Java, VisualAge for Java and so on.

* www.developer.ibm.com/devcon/

Mark Cathcart is Principal Consultant to IBM
System/390 Division in Europe, Middle East
and Africa for new software technology and
software strategy. His current assignment is
object-oriented and component-based software
and software development including Java,
Enterprise Java and Component Broker and
XML. Other areas he is responsible for include
e-business and the Internet, Client/Server and
Open Systems.

Mark is a "certified" Consultant IT Specialist
and a member of the IBM S/390 Software
Design Council. In 1999, he was elected to the
position of Technical Staff Member in the IBM
UK Technical Consultancy Group. Mark is also
a Knight of the order of VM and joined IBM
Systems Engineering in 1987 to become a
'Poacher turned Game-keeper' after spending 13
years as an IBM customer. This included four
years with responsibility for the VM systems at
a leading New York bank. Mark likes to play
"devils advocate" at IBM and has a unique
insider's perspective.




by Verlyn Johnson

BM SanFrancisco is
an industry leading ini-
tiative for developing
object-oriented server-
based applications

using pre-built, pre-
tested application busi-
ness components written in Java. It also is key
to IBM’s e-business strategy, which helps busi-
nesses exploit the network economy by trans-
forming their business processes with Internet
technologies. It will allow application developers
to combine capabilities from products such as
IBM’s Net.Commerce and MQSeries with capa-
bilities from existing and newly developed com-
ponent-based applications.

Currently in its third release, IBM
SanFrancisco is attracting significant industry
interest, with more than 1,100 Independent
Software Vendors and customers with licenses
to Sankrancisco. A number of SanFrancisco
applications became available in 1998, while
more than 100 Independent Software Vendors
(ISVs) have projected delivery of new applica-
tions based on SanFrancisco during 1999.

ISVs success stories

Two sessions are planned for Solutions 99
where ISVs will relate how they have success-
fully increased productivity while developing
and deploying applications based on
SanFrancisco.

Provider Solutions will describe how they
built the ProviderFirst OutcomesManager
System. It is a SanFrancisco-based solution and

Provider

Solutions®

set of reusable components that allow home
health agencies to meet U.S. government data
collection and analysis requirements for
Medicare patients. The session will share
Provider Solutions” experience using

SanFrancisco, VisualAge for Java and

» IBM SanFrancisco

WebSphere to build the application. Topics cov-
ered include the transition from requirements
to models, implementation using SanFrancisco,
use of JavaBeans and servlets, and the use and
extension of SanFrancisco components.

FrontEnds will describe how they have used
SanFrancisco to achieve a five-fold increase in
programmer productivity. The application they
have developed is a billing, scheduling and
workflow system for a healthcare network in
Texas. The session will focus on the develop-
ment advantages of using SanFrancisco and
FrontEnds™ experiences in using the product.
This session also will include a short overview
on the common business objects, application
business components and infrastructure for dis-
tributed object applications that is delivered
with IBM SanFrancisco.

Product expertise and directions

Several presentations will describe tech-
niques that have proven effective in building
SanFrancisco-based applications and how
SanFrancisco components can be used in con-
junction with other IBM products. A separate
session will provide additional details about
how IBM plans to transition SanFrancisco to
run on Enterprise Java Servers.

The session, Performance Tips for Java
Server Objects and SanFancisco Schema
Mapping, will review the SanFrancisco Schema
Mapping tool and how it can be used to effi-
ciently map business objects to relational data-
bases (RDBs). It also will cover tips and tech-
niques on how to achieve the best performance
for SanFrancisco Java applications.

Another session, Building Thin Client
Applications Using SanFrancisco Business
Objects and WebSphere, will show how to
enable SanFrancisco applications for e-busi-
ness. It will explain how a three-tiered model
can be applied to both fat and thin client front-
ends. The session will show how to use a
JavaBeans-based approach together with the
WebSphere Application Server to allow busi-
ness applications to run over the Internet or
intranet. The session will show how to utilize
JavaBeans, XML, WebSphere and VisualAge for
Java to increase development productivity.

A hands-on session will be conducted to pro-

vide experience in using MQSeries and

SanFrancisco together. The session will review
how to:
+  Setup an MQSeries test

SOLUTIONS

PRESENTE

ment
» Write a Java client/

server application using

MQSeries
+  Connect external applications with

SanFrancisco applications by using MQSeries

The future transition of SanFrancisco to run
on WebSphere EJB servers will be reviewed in
the session, SanFrancisco Migration to
Enterprise JavaBeans and WebSphere. This ses-
sion will describe the plans for accomplishing
the transition, including migration of existing
applications and business objects. It also will
indicate what developers can do today to posi-
tion their Sanlrancisco applications and busi-
ness objects for migration.

Demonstrations and SanFrancisco
Specialist Certification
Several demonstrations, based on the tech-

nical sessions, will be shown in the exhibit hall.

They will include an ISV application’s use of
SanFrancisco, prototypes showing how to use
SanFrancisco alone and with other IBM prod-
ucts to build e-business applications.

IBM will be offering SanFrancisco Specialist
Certification testing at no charge during
Solutions "99. Generally this is a $120 (U.S. dol-
lars) charge. For more information, read about
the test and the requirements on our Web site:
www.software.ibm.com/ad/sanfrancisco/cert_app
dev.html.

Summary

IBM SanFrancisco is being used today by
Independent Software Vendors and customers
to achieve large gains in productivity as they
deliver Java applications. The sessions and
demonstrations at Solutions "99 will tell how
they are doing this and share valuable tech-
niques that have been learned. The sessions
also will discuss the future of SanFrancisco
and how the product will evolve.

Additional information on IBM
SanFrancisco is available at:
www.software.ibm.com/ad/sanfrancisco.




- A servlet architecture for
IBM SanFrancisco

|
|

by Richard Cook

" his article builds
upon the “Creating a
Servlet Gateway to an
IBM SanFrancisco
Logical Network™ arti-
cle by Mickey Nix, pub-
lished in the December 1998 issue of the
Developer Connection Technical Magazine. 1t is
based on the NCF Examples code provided on
the IBM SanFrancisco 1.3.0 CD. It uses the
architecture outlined and implements a reusable
implementation that gives you a framework for
creating applet or application front ends that
connect to SanFrancisco via servlets. The servlet
acts as the SanFrancisco client on behalf of the
applet or applications. By doing this, the applet
does not need to download any of the
SanFrancisco classes and can be as thin as pos-
sible. With only a few classes, the applet or
application can access an IBM SanFrancisco
logical network.

The article briefly examines the servlet
architecture and how it communicates with
SanFrancisco. Then, it discusses how to devel-
op code using the servlet architecture and how
to deploy the code.

Servlet architecture
The architecture consists of two servlets:
The SFProcess servlet and the MainServlet.
The SFProcess servlet is responsible for calling
Global.initialize(), which should be called when

the servlet engine is started. This helps ensure

The IBM

SanFrancisco Servlet
Architecture is a means to
standardize thin-client
access to SanFrancisco
applications.

that everything is properly initialized before
any servlet requests are received by the engine.
After calling Global.initialize(), the SFProcess
servlet suspends its distributed process in
preparation for a servlet request.

Servlet requests are handled by the
MainServlet. A Java client (applet or application)
creates a ServletRequest object, which contains
the URL of the MainServlet and the data for a
command that the servlet executes on behalf of
the client. When the ServletRequest is executed, a
connection is opened to the Web server and the
data is sent to the servlet using Java serialization.

When the ServletRequest is
received, the MainServlet de-
serializes the data from the client
and goes to the SFProcess servlet
for a Work Area. Then the
MainServlet dynamically loads the
command class requested by the
client and hands off the data to the
command. The command executes
any SanFrancisco code, beginning
and committing transactions,
accessing persistent objects and so

on. Next, it passes any data back to
the MainServlet, which completes
the ServletRequest by serializing
any data and passing it back to the client as
shown in Figure 1.

Walk-thru

Let’s take a look at some sample client code
to see how it communicates with the
MainServlet. First, the client creates a
hashtable object that contains the particular
data needed to perform the task at hand. Let’s

Hashtable h = new Hashtable(3);

h.put(“firstName”, “Lou");

h.put(“lastName”, “Gerstner”);

h.put(“mailingAddress”, 123 IBM Lane, Somers NY 11111");

say we are going to create a new Customer
object and need to pass the data from the
applet to the MainServlet. Data is stored in the
hashtable using String objects as the keys.

It is important to note that any data you put
into the hashtable should be a Java primitive,
string, or object that implements the serializ-
able interface. The servlet architecture uses
Java serialization to pass the data to the

MainServlet.

Next, create a new
ServletRequestDataContainer and give it the
hashtable. In addition, there are two attributes
the client must set in all instances of
ServletRequestDataContainer.

*+  CommandToken: This is a string attribute
that is the fully qualified class name of the
class that the MainServlet will load and
execute on behalf of the client. This is cov-
ered in more detail later in this article.

+ TransactionCode: This attribute can be one
of three things:

WebSphere

Figure 1. SanFrancisco servlet architecture

— TransactionCode. TRANSIENT _TX: This
ServletTransaction begins and ends a
SanFrancisco Transaction. There is no
need for the MainServlet to keep track
of the particular SanFrancisco Work
Area that is used to perform
SanFrancisco Client work on behalf of
the applet. When the servlet request is
completed, the work area is put back
on the stack of available work areas it
keeps on hand for requests.

— TransactionCode.PERSISTENT _TX: This
signifies that the client is expecting this
ServletTransaction to execute a com-
mand that may begin a SanFrancisco
Transaction. access objects, and then
want to keep a lock (Optimistic,
Pessimistic, and so on.) across
ServletRequests. When the command is
finished executing the MainServlet sus-
pends the Work Area and stores it in a

CONTINUED ON PAGE 26



hashtable using the 1D as its key. The
MainServlet then gives the ID number
to the Client in a response object. More
on this later.

An int. The client has previously issued
a ServletRequest that locked objects by
starting a SanFrancisco Transaction,
accessing objects, and then not commit-
ting the transaction before finishing the
servlet transaction. The MainServlet

then passes an 1D number back to the
client which the client should then use
in a subsequent ServletTransaction (via

another ServletRequestDataContainer)
to finish the SanFrancisco transaction.
That ID number should be used to set
the TransactionCode.

Then, the client applet creates a
ServletTransaction object using a URL that
points to the MainServlet and the
ServletRequestDataContainer, which contains
the hashtable of data as shown in Listing 1.

An attribute of the ServletTransaction that
the client should set is the ExpectResponse
boolean. If the client is expecting the MainServlet
to send back a ServletResponseDataContainer,
then this should be set to true. The default is set
to false.

The client applet executes the request as
shown in Listing 2.

Calling doTransaction() causes the connec-
tion to the host Web server to be opened, an
input stream to be opened and the
ServletRequestDataContainer to be serialized
and sent to the servlet.

The servlet receives the request and
unpacks the ServletRequestDataContainer.
Depending on the request’s transaction code, it
picks up a transient work area, creates a new
persistent work area for long running transac-
tions or retrieves an existing work area.

The servlet then looks at the request’s com-
mand token and attempts to dynamically load
the command class using this token and creates
a new instance of it. It then calls the initialize
method of the command object passing in the
Servlet RequestData Container and the servlet
itself to allow the command to prep itself for the
command’s actions. Next, the servlet calls the
command’s doTransaction method that contains
the business logic of the transaction.

The commands executed by the servlet
should implement the ServletCommand inter-
face. Let’s look at a sample command as shown
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in Listing 3.

The doCommand
method is where the
code that the
ServletCommand
executes on behalf of
the client should
reside. Usually a
transaction begins
and persistent
SanFrancisco objects
are accessed in this
method.

In doCommandy),
the client data is
retrieved from the
hashtable and then
passed to
createCustomer() on
the CustomerFactory
class. This command
returns data in a
ServletResponse
DataContainer, again
using a hashtable
and string keys. The
ServletRequest was
set to expect a
response so the
MainServlet takes
this response object,
serializes it and sends
it back to the client.

The
ServletResponse
DataContainer con-
tains an exception
field that can be used
to pass exceptions
back to the client. In
doCommand(), any
SFExceptions gener-
ated should be
caught and then
passed back to the
client as an exception
object that does not
extend from
SFException.

Additional notes
The Servlet
RequestData

Container contains
fields that store the
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Listing 1. Hashtable data

Listing 2. Execution of request

Listing 3. Sample command




user name and password for a request. Servlet
Commands can use this data and utilize the
methods in the SFProcess servlet to authenticate
and authorize a user. See the documentation for
the SFProcess servlet that is included on the
SanFrancisco CD.

The Servlet architecture can handle long
running transactions. It does this by storing
work areas in a hashtable. The attributes of this
hashtable can be fine tuned depending on the
load the servlet may need to handle.

“WorkAreas Capacity” and “WorkAreas
LoadFactor” are the two parameters that can
be passed on to the hashtable constructor in
the MainServlet’s init method.

If using long running transactions, the
Servlet’s WatchDog thread should be started. It
monitors the work areas that are stored in the
hashtable. If a work area ages beyond a certain
threshold, the WatchDog thread resumes the
work area, rolls back any transaction that it
may have been in and removes the work area
from the hashtable. This effectively retires the
work area, so resources or persistent objects are
not locked by a dead client that never returns.

“StartWatchDog” should be “true” for the
thread to be kicked off.
“WatchDogCheckMillis” tells the WatchDog
thread how often to check for old Work Areas.
“WatchDogTTLMillis” sets the age threshold
for the work areas. Look at the MainServlet’s
init method for examples.

Deployment

The SFProcess and MainServlet servlets can
be deployed on any Web server that supports
Java servlets. These servlets were developed
and tested using WebSphere 2.0. Whichever
servlet engine is used, it is important that the
SFProcess servlet is loaded upon startup of the
engine. This causes the servlet’s init method to
be called, which in turn calls Global.initialize().
The MainServlet should be loaded on its first
service request.

The following steps for deploying the
servlet are for WebSphere 2.0 and the IBM
HTTP Web Server that comes with WebSphere
2.0. Note: The RMI patch for WebSphere 2.0
must be installed.

1. Install the SFProcess classes in a directory.

2. Install any ServletCommand classes in a
directory. Probably the same directory as

the SanFrancisco application’s classes.

3. Run the WS administration applet.

a) In Setup:Java Engine add the directories
for SanFrancisco, the ServletCommands
you have developed and your
SanFrancisco application’s classes to the
Application Server Classpath. Your
servlet commands classes will probably
be in the same directory as the
SanFrancisco application’s classes. Add
the directory for the SFServlet classes to
the Reloadable Servlet Classpath. It is
important to note that the SanFrancisco
directory should be the first path in the
Application Server Classpath.

b) Save these changes.

¢) Go to the Servlets:Configuration screen
and configure the SFProcess Servlet
and the MainServlet. In the Name field
of the servlet configuration screen,
name the servlets SFProcess and
MainServlet appropriately. Set the
SFProcess Servlet to load at startup.
The Load at Startup indicator might not
display correctly, but it does load the
servlet at startup when set. The Save
button might appear to be disabled
(gray) when the Load at Startup option
is changed from No to Yes. Type some-
thing in the Description field to enable
the save button and click Save to save
the servlet’s configuration.

d) Make sure the SanFrancisco Server is
up and running, and then restart
WebSphere. Shut down the WS service
and the IBM HTTP service. Next,
restart the IBM HTTP service.
WebSphere starts up along with it and
loads the SFProcess Servlet, which calls
Global.initialize(). The MainServlet is
loaded when the first Web server
request is received.

e) Verify that the SFProcess servlet ini-
tialized properly by going to the Server
Execution Analysis:Monitors:Loaded
Servlets screen in the WS administra-
tion applet.

f) Make sure the applet classes and HTML
page are in the Web server’s directory
structure so that it can send the applet

classes to clients.

g) Start testing the applet.

Summary

The IBM SanFrancisco Servlet Architecture
is a means to standardize thin-client access to
SanFrancisco applications. Since it is based on
the general method of moving data between
the thin client and the application, it can be
reused by SanFrancisco systems that need
access through applets or applications through
a servlet. The architecture takes care of the
data passing mechanisms as well as managing
Work Areas for the active clients. With a stan-
dard architecture, you can speed up the devel-
opment time of your SanFrancisco applications
with Web access.

Richard Cook is a Technology Consultant with
the IBM Solution Developer Marketing organiza-
tion in Waltham, Massachusetts. In the past, he
has worked with custom client/server applica-
tions and has worked with Java since late 1995
when he joined a Java development tools com-
pany. Since 1998 he has been working with IBM
SanFrancisco helping vendors develop distrib-
uted object business applications. He can be con-
tacted at richcook@us.ibm.com

Editor’s Note: The sample code included in this article
can be downloaded from the Developer Connection
Web site at www.developer.ibm.com/devcon/. The

code also is available on the July CDs.
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B he following are FAQs pertaining to the

IBM WebSphere Application Server that are of
general interest. The questions have been edit-

ed for length and clarity but are typical ques-
tions asked by developers. We plan to include
FAQs on other topics of interest to solution

developers in future issues.

Q:
A:

Q:
A:

What is WebSphere Application Server?
WebSphere Application Server is a complete
Java-servlet-based Web server environment.
It consists of a run-time environment and an
integrated tools environment and runs with
most existing HTTP servers.

What is IBM WebSphere Performance Pack?
WebSphere Performance Pack is composed
of three major components:
*  An enterprise file system

* A caching proxy server
+ A load balancing server monitoring tool

These features provide a combination of

caching, filtering, file content management and

replication, and load balancing into a single

Internet-Hosting infrastructure.

Q:
A:

Q

What is WebSphere Studio?

The IBM WebSphere Studio is a tool envi-
ronment for building Web applications that
leverage the WebSphere Application Server
and extend Web sites beyond publishing
and Information transactions. WebSphere
studio combines a Web development work-
bench and servlet generation wizards with
IBM's VisualAge for Java development envi-
ronment and Web site development tools
from NetObjects, such as ScriptBuilder,
Fusion and BeanBuilder.

When would a customer use the IBM
WebSphere Application Server family, and
when would it be better to use Lotus
Domino?

¢ Lotus Domino and IBM WebSphere

Application Server meet different customer
needs.

Domino is for customers who are
focusing on collaborative/workflow solu-
tions and want to build intranet/extranet
Web applications that integrate business
processes with existing I'T systems.
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WebSphere Application Server

WebSphere is for organizations building
transactional Web applications using Java
servlets and Enterprise JavaBeans.
WebSphere provides a platform to upgrade
from a publishing-based Web presence to a

transactional selling environment.

Does IBM WebSphere Application Server
2.0 include the Apache server?

: No. IBM WebSphere Application Server 2.0

includes the IBM HTTP server. However, it
supports Apache 1.3.2.

: What is the IBM HTTP server that comes

with WebSphere Application Server 2.07
The IBM HTTP server is an HTTP server-
based on technology from the Apache
HTTP server, with additional SSL-based

security and performance features.

How does WebSphere software connect to
the AS/400 database?

You can connect to the AS/400 database
using either CGI programs or Net.Data.*
With AS/400* 4.3, you can use JDBC from
Java CGls or servlets as well as AS/400 Java

toolkit classes for record level access.

: Can we use servlets and JSPs on the

AS/400 platform today?

Yes, 05/400 version 4.3 supports the
WebSphere Application Server, which pro-
vides the capability to run Java servlets as

well as JavaServer Pages (JSPs).

Are WebSphere products compatible with
HTML editors such as Microsoft FrontPage
and Macromedia Dreamweaver?
WebSphere products are compatible with
many HTML editor including the two
mentioned above. WebSphere creates Java
server pages, which are cross-platform,
instead of active server pages, which are
not cross-platform.

What type of education is available for
WebSphere?

IBM WebSphere has a Web-based tutorial
located at www.software.ibm.com/web-
servers/appserv/tutorial.html



Q:

»

I am not able to load a DLL library with
WebSphere. What should I do?

You need to get access to the jeicsecidll file

through the PATH statement rather than
through the CLASSPATH or anything in
the JVM.PROPERTIES file. Make sure the
location of jcicseci.dll is in your PATH
statement.

How do I get servlets to reload without
stopping and restarting the Web server?

In order to have servlets reload so that you
can see changes you've made, put the
servlet in the WebSphere/servlets directory.
The /servlets directory must not be in the
system classpalh, that is, not in the class-
path specified in jvm.properties.

Also, in the servlets.properties file, there
is a servlets.classpath directive that can be
used to extend the reloadable classpath.

You can add directories to allow reload-
able servlets to be placed in directories

other than the /servlets directory. Directories
specified in this directive are used as a root
directory (just like the /servlets directory) so
you must maintain the package structure
under these directories as well.

Make sure that all of the classes your
servlet needs are using the same directory
in the servlets.classpath. There is cur-
rently a bug with this directive that
makes servlet classes loadable only
from the directory structure from which the
servlet's class file is loaded. This is because
each directory in the servlets.classpath is
loaded in a different classloader. Therefore,
servlets loaded from a reloadable directory
other than the servlets directory do not
have access to classes in other reloadable
directories (such as the /servlets directory).

If you add an entry to the servlets.class-
path property and put your servlet in that
directory, WebSphere automatically reloads
your servlet code if it changes. The only
time that WebSphere does not automatically
reload is if the servlet is loaded out of the
system classpath.

How can the IBM WebSphere Performance
Pack help me?

IBM WebSphere Performance Pack is a
combination of software that can be applied
to a Web server to help reduce server con-

gestion from Web traffic, increase content

availability and improve Web server perfor-
mance. It uses caching functionality from
IBM Web traffic express (WTE), load bal-
ancing from IBM eNetwork™ dispatcher
(eND) and the enterprise file system that

can be placed anywhere in the network

from the Transarc Andrew file system (AFS).

To learn more about the performance
pack, visit www.software.ibm.com/web-
servers/perfpack/index.html.

o

How do I use the generic object servlet in
WebSphere?
GenericObjectServlet is a CORBA object

server embedded within a servlet. It sup-

»

ports any set of objects specified in the
applicationserver_root/web/classes/Objectl
mpl.properties file. Entries within this file
have the form:

interfac: ation-name

All names are fully qualified, that is, they
specify the package, too.

To enable GenericObjectServlet to sup-
port the greeter object for HelloWorld, use
a text editor to add the following interface-
implemenlali()n entry to the

Objectlmpl.properties file:
getting.started.Greeter = getting.started._Greeterimpl

The left side is the fully qualified name of
the greeter interface; the right side is the

fully qualified name of the greeter imple-
mentation.

Note: Class com.ibm.jbroker.Generic
ObjectServlet is in the WebSphere applica-
tion server CORBA support ihmjbrt.jar file.
To allow the Web server to successfully
activate GenericObjectServlet, the
nefjvm.classpath property in the jym.prop-
erties file must include the ibmjbrtjar file
and the directory containing the
Objectlmpl.properties file. The jym.proper-
ties file is in directory:

. <as_r()()l>/pr0|)('rli(-s/.~'vr\'(-r/

IBMWebAS/ servletservice

+  where <as_root> = drive and directory

in which WebSphere has been installed.

Starting an object servlet is done auto-
matically when the client calls method
com.ibm.jbroker.Utility.getlHome() to

obtain a reference to the servlet's IHome.

o

See object servlet solutions for a complete
description of WebSphere Application Serv-
er CORBA support’s object servlet features.

Why are CORBA server-to-client callbacks,
as implemented in WebSphere, critical?
Callbacks are crucial for client applets,
because unsigned applets cannot listen for
incoming TCP/IP connections. HTTP is a
connectionless protocol and, as such, call-
backs are not available when the client and

server ORB are communicating using [IOP

over HTTP.

What features make the CORBA support,
found in WebSphere Application Server, a
valuable addition to WebSphere?

The following features make the CORBA

support in WebSphere an extremely power-

ful addition:

* Object interfaces can be defined directly
in Java. WebSphere application server
CORBA support includes a Java-to-"dis-
tributed Java" compiler (similar to the
Java RMI compiler, RMIC) that works
directly with your Java interface.class
files to create CORBA compliant distrib-
uted versions of them.

*  Object interfaces also can be defined in
CORBA IDL. WebSphere application
server CORBA support includes an IDL-
to-"distributed Java" compiler that gen-
erates CORBA-compliant distributed
object bindings for interfaces written in
IDL.

* CORBA name service.

+  Easy server-side object creation.
WebSphere application server CORBA
support include IHome and EJBHome
classes: distributed object factories that,
when added to an object server, define
the set of objects it will support and
allow clients to create new remote
objects.

* Automatic object server activation.

»  Extensible. generic object server. The
GenericObjectServlet class, provided in
WebSphere as part of the CORBA sup-
port, implements a CORBA object server
that is ready for use, right out of the
box. The developer needs to specify the
set of objects the server supports and

then configure the client to use

GenericObjectServlet.

CONTINUED ON PAGE




CONTINUED FROM PAGE 29

Pass objects by value.

Use Java exceptions in a CORBA envi-
ronment.

Server-to-client callbacks. Servers may
sometimes need to notify clients of some
event or change in state. The
WebSphere application server CORBA
supports server-to-client callbacks when
a direct IIOP connection is available
between a client and server. Callbacks
allow a server to invoke methods on a
client without establishing a new con-

nection between the two.

Q: | enabled user profiles, but all that is stored

in the database are the USERIDs. Where is
the rest of the information?
: When you set up user profile support in
WebSphere, you define a username and pass-
word for accessing the JDBC database. The
user must have insert and update permissions
on the table where the profiles are stored.
The WebSphere API addUser method
adds the record (an SQL insert) when it is
called. As data is added to the record with
other API calls (the various setXXX ecalls), an
update is performed. Therefore, the
WebSphere JDBC user needs insert and

update permissions to the table.

: How easy would it be to move a Windows

based Java servlet application to AS/4007

: Java servlets written using the WebSphere

application server for Windows NT should
run on the AS/400 WebSphere Application
Server with little or no change required to

the Java code.

: Does WebSphere software handle multi-
membered physical files smoothly?

¢ Yes, the HTTP server serves pa

either members’ source physical files or
ASCII stream files from the IFS file system.

: Under 05/400 4.3, will WebSphere work
with both the current HTTP server and the
Apache server?

: The WebSphere application server current-
ly works only with the AS/400 HTTP serv-
er. The Apache server, currently in beta,
does not support WebSphere. Development

is continuing to evaluate this requirement.

Software and hardware components
needed to run Enterprise JavaBeans on AIX

THE FOLLOWING ARE THE HARDWARE AND
SOFTWARE REQUIREMENTS NEED TO RUN
ENTERPRISE JAVABEANS ON AIX:

SOFTWARE LICENSE PROGRAM
PRODUCTS

THE IBM VISUALAGE FOR JAVA,
EnTERPRISE EDITION FOR AIX VERSION
2.0 IS DESIGNED FOR BUILDING JAVA APPLI-
CATIONS, APPLETS, SERVLETS AND JAVA
BEAN COMPONENTS. IT CONNECTS CLIENTS
TO EXISTING SERVER DATA, TRANSACTIONS,
AND APPLICATIONS. IT IS SUPPORTED BY
AIX VERSIONS 4.2.1 AND 4.3.X.

OTHER SOFTWARE REQUIREMENTS
AND PREREQUISITES

+ TCP/IP COMMUNICATION IS SET UP AND
CONFIGURED PROPERLY

» NEeTscAPE NAVIGATOR 4.04 OR HIGHER
1S INSTALLED (JDK 1.1 IS ENABLED)

» FOR APPLICATIONS CONTAINING SWING
COMPONENTS, INSTALL JDK 1.1.2 OR
HIGHER

RS/6000 HARDWARE MODELS
AND FEATURES

THE IBM RS/6000 FAMILY HAS A LARGE
SERIES OF WORKSTATION SERVERS AVAIL-
ABLE TO MEET THE REQUIREMENTS OF
COMPANIES, BUDGETS, AND SYSTEM
CONFIGURATIONS.

solutions

THE ENTERPRISE SERVER MoDEL F50 Is
RECOMMENDED FOR DEVELOPERS GETTING
STARTED IN EITHER PORTING OR ENHANCING
APPLICATIONS USING VISUALAGE FOR JAVA
EnTERPRISE EDITION FOR AIX VERSION
2.0. THE F50 SUBSTANTIAL PERFORMANCE
IS A LIGHTNING-FAST 332 MHz PROCES-
SOR SERVER.

THE F50 SERVER CAN HELP GET YOUR
CRITICAL APPLICATIONS UP AND RUNNING
FAST. THE F50 MICROPROCESSOR IS A
PowerPC604& wiTH MINIMUM MEMORY OF
128 MB AND MAXIMUM MEMORY OF 3 GB.

THE INTERNAL DISK MINIMuMm IS 4.5 GB
AND THE MAXIMUM IS 172.8 GB.

THE RECOMMENDED DISPLAY RESOLUTION
1S 1024 x 768 using A RS6K GXT120
GRAPHICS ADAPTER.

DiSK SPACE REQUIREMENTS:

« 325 MB FOR FULL PRODUCT WHEN
INSTALLED AS A STANDALONE CONFIGU-
RATION OR 300 MB FOR THE FULL PROD-
UCT WHEN INSTALLED AS A CLIENT-ONLY
CONFIGURATION.

» 192 MB FOR PAGING SPACE

« 200 MB MINIMUM FOR EACH USER
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We listened to you, our Business
Partners... and have announced
iBM PartnerWorid!

What is IBM PartnerWorld?

® A tiered, value-based marketing and enablement program for IBM Business Partners across IBM tech-

nologies and e-business solutions

® Phased implementation approach to integrate many existing programs and Web sites
® Four key program tracks based on business models (Developer, software, Personal Systems and Systems —

with Services across all tracks)

What does this mean to you?

® Commitment to Developers as an integral part of IBM’s Business Partner community
® Extension of Your Business Opportunities embracing IBM’s solutions

® Lowering Your Business Costs providing simplification and choice

® Increasing Your Business Responsiveness with faster access to information and tools

For more information visit www.developer.ibm.com

www.developer.ibm.com/devcon/

Choose the membership level

that works for you...

You can tailor your participation in the
Developer Connection to match your interests and
requirements. Your subscription entitles you to
unlimited Web access for all content in your sub-
scription level. A set of CDs is available for Member,
Advanced and Premier levels.

Guest Level is available on the Web to any
registered application developer. From our Web site
at www.developer.ibm.com/devcon/, you can regis-
ter, review and download sample source code, tech-
nical documents, hints and tips, utilities and Java
and Internet tools. All free of charge.

Member Level includes the Guest Level con-
tents, while giving you the additional value and con-
venience of a CD collection, a Java-enabled browser,
additional documents and non-1BM tools. At the
Member Level, you'll also receive a subscription to
the Developer Connection technical magazine.

Advanced Level builds on the Member
Level by also providing compilers, toolkits for IBM
operating systems and IBM e-business Servers. With

an Advanced Level subscription, you have the tools

to develop Java, Internet, e-business Servers or
purely operating system applications.

Premier Level further extends the Advanced
Level and adds system management tools and a
comprehensive test environment for IBM Software

Server appli('alinns.

Subscribe Today:

US 1-800-6DEVCON (633-8266)
Brazil 0800-111 426 r. 1351
Canada 1-800-561-5293

Argentina 0-800-IBM YA (426 92)
\sia/Pacific +61 2-9354 7684

800-DE-IBM (800-33-426)

Venezuela

Europe +45 4-810 1500
Japan 0s2pid@jp.ibm.com
Mexico 387-5990 (D.F.)
Colombia 9800-17555 (Nacional)
\ustria 0660 8705

Germany 0130812177
Phone numbers for customers in other countries are

listed on page 31.



